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Conventions used in this Manual 

Normal text is used to provide information and instructions. 

Bold text refers to text that is displayed on the screen. 

UPPERCASE text, for example ENTER or ALT, refers to keys on the PC 
keyboard. '+' is used to show that you have to press two keys at the same time, 
for example, ALT+F. 

All eight digit numbers are PerkinElmer part numbers unless stated otherwise. 

NOTE:  A note indicates additional, significant information that is provided with some 
procedures. 
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About This Manual 

The FL WinLab Software is an extensive and easy to operate software package 
for luminescence spectroscopy (fluorescence, phosphorescence and 
bioluminescence).  

FL WinLab is operated under the MS Windows TM environment.  In order to 
work with FL WinLab a basic knowledge of Windows is necessary. When 
working with Windows for the first time, you should first review the Windows 
documentation. 

This FL WinLab Software User’s Guide describes the installation of FL WinLab 
and gives an overview of FL WinLab Software and details on how to use the 
different application programs available.  The first four chapters give general 
information about using FL WinLab Software to setup up your instrument and 
work with applications: 

• Introduction - Installing and starting FL WinLab Software, and an overview 
of the software.  

• Configuring FL WinLab - Setting up multi-user directory structures and 
configuring the Function keys and the Toolbar. 

• Instrument Status - How to set up your instrument with non-application 
specific parameters. 

• Using Application Methods - General details on working with application 
methods (saving, opening, printing, starting/stopping), a description of the 
GLP and Expert modes, and details on viewing the data collected.  

The rest of this user’s guide is dedicated to the individual application packages: 

• The Arithmetic Application - Data manipulation tools for spectral 
manipulation or data conversion, comparison and reduction. 

• The Single Read Application - A simple data collection package for 
intensity, concentration, polarization, or anisotropy measurements at fixed 
wavelengths.  

• The Scan Application - A data collection package that enables you to collect 
single scans, 3D scans, kinetic scans and accumulation scans of 
luminescence measurements (fluorescence, phosphorescence and 
bioluminescence). 
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• The TimeDrive Application - A data collection package that enables you to 
collect time-dependent luminescence measurements (fluorescence, 
phosphorescence and bioluminescence) at fixed wavelengths with defined 
intervals over a specified period of time. 

• The Wavelength Program Application - A data collection package enabling 
you to collect time-dependent multiple-channel measurements, which can be 
programmed for the 4-cellchanger or single position cuvette holders with 
multiple wavelengths. 

• The ICBC Calibration module - A calibration module for converting raw 
data from a variety of time-dependent data collection applications (Ratio 
Data Collection, Fast Filter, TimeDrive, Wavelength Program) into [ion] vs. 
Time. 

• The Concentration Application - A method for creating a linear graph from 
reference standards and then measuring the concentration of unknown 
samples, for use with standard cuvette holders, the sipper accessory or an 
external autosampler. 

• The TLC Scan Application - A data collection package enabling you to scan 
continuously over a flat sample using the Plate Reader accessory to produce 
2D and 3D datasets.  

• The Plate Reader Application - A data collection package enabling you to 
collect data from a variety of microplate formats, using the Plate Reader 
Accessory. Data can be collected in end-point or kinetic modes, using a 
user-defined wavelength program.  

• The Fast Filter Data Collection Application - A data collection package 
enabling you to collect multiple (up to 4) wavelength data channels rapidly 
using the Fast Filter Accessory.  

• The Ratio Data Collection Application - A method for measuring changes in 
intracellular concentration of free ions in living cells using ion-specific 
fluorescent probes. 

• The Validation Application - Tests the sensitivity (signal-to-noise ratio) and 
wavelength accuracy of the instrument, and produces a validation report, 
which can be printed or saved.   
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Use of FL WinLab with the LS 45 and LS55  

FL WinLab can be used to control the LS 45, LS-50B and LS 55 Luminescence 
Spectrometers. The LS 45 differs in several areas to the LS 50B and LS 55, these 
being: 
 

Feature LS 45 LS 50B/55 

Excitation and emission slits Fixed (10nm) Variable 

Emission filter wheel Not applicable Standard 

Excitation filter wheel Not applicable Standard 

Polarizers Not applicable Optional 

Fast Filter accessory Not applicable Optional 

Plate Reader accessory Not applicable Optional 

4-position cellchanger Not applicable Optional 

Biokinetics accessory Not applicable Optional 

Low Temperature accessory Not applicable Optional 

Stirring Not applicable Optional 

Because of this there are aspects of the software that either do not apply, or 
behave differently when used with an LS 45.  The following points must be 
noted when using an LS 45: 

 Wherever a slit width appears in an FL WinLab application, set the 
parameter entry to 10. 

 The cuvette position column in the Wavelength program application can 
only be set to 1. 

 The emission filter selection in the concentration application can only be 
set to Open. 

NOTE:  Differences that occur within the Status application are described in that 
chapter, starting on page 39. 
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Help Functions 

In addition to this manual, FL WinLab contains extensive on-screen help 
functions.  

On-screen Help 

Whenever you need on-screen help, simply press the F1 function key on your 
PC keyboard or use the commands in the Help menu. 

Please note that images within the on-screen help contain hotspots: wherever the 
mouse pointer changes to a hand, simply click with the mouse to obtain 
additional help on the corresponding parameter or button.  

All screen shots displayed in the on-screen help and this manual were recorded 
from a Windows 95 system at 800x600 SVGA screen resolution, and may look 
different on other systems.  

Quick-help 

Quick-help is an on-screen help system which is intended to help the first-time 
user to become familiar with the functions of the screen objects without having 
to click on them first. 

The Quick-help function is activated when an application is started the first time. 
However, you may switch off the function.  

 To do switch off Quick-help, click the Quick-help button, . 
The Quick-help function is now deactivated and the button changes to show 

a cross, . 

 To switch on the Quick-help function again, click the button again. 
When the application is closed the current status of the Quick-help button is 
stored. The next time the application is started this status is restored. 

 To view quick-help for a particular parameter, leave the mouse indicator 
over the object of interest.   
A yellow textbox will appear containing information on the selected object. 
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For example, if you move the mouse indicator to the excitation slit textbox 
the following information will appear: 

 
The first line contains a brief description of what the entry field is used for. 
The second line describes which values are valid for the entry field. 
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Installing FL WinLab Software 

NOTE:  This procedure MUST be carried out by a Windows Administrator. 

1. Insert your FL WinLab CD. 

2. From the Windows Start menu, select Run. 
The Run dialog is displayed 

3. Enter d:\fl.exe, where d:\ is the drive letter for your CD and then click OK. 

4. Follow the instructions on the screen to install the FL WinLab software. 

5. When the software is installed, enter d:\FLInstall2000XP.vbe in the Run 
dialog and then click OK.  
Replace d:\ with the drive letter for your CD. 
You should only enter this text if the installation directory is c:\flwinlab. If 
you selected a different installation directory you must specify this 
directory as an argument, for example 
d:\FLInstall2000XP.vbe f:\FLPrograms 
This step sets the permissions on the FLWINLAB folder so that Windows 
users other than Administrators can use the software.  
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Working with FL WinLab 

Starting FL WinLab 

1. Turn on your instrument. 

NOTE:  Before starting data collection, it is necessary for the instrument to warm up for 
15 minutes after switching on. 

2. Turn on the PC. 

3. From the Windows Start menu, select FL WinLab in the PerkinElmer 
Applications group. 
The FL WinLab Software screen is displayed. 

The FL WinLab Software 

From the FL WinLab Software, application programs and specific application 
methods can be started, data can be edited and data treatment performed. 

 

Menu bar 

Application toolbar

Status line 

Window 

Minimized windows
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The Menu Bar 

The menu bar contains the menus of FL WinLab. Click on a menu title to open 
the menu and select a command from the list. 

 

Menu Contains commands for ... 

File Opening, saving, and printing files and exiting FL WinLab 

View Viewing data 

Utilities Configuring FL WinLab 

Application Starting applications 

Data handling Data manipulation 

Window Handling the windows of the software 

Help Starting the on-screen help 

Application Toolbar 

The application toolbar contains icons as shortcuts for applications. Click on an 
icon to start the corresponding application. The application toolbar can be 
customized, see page 34. 

Status Line 

Shows the instrument status and a short information text for the selected icon, 
command or parameter. 

Windows 

The FL WinLab Software contains several windows: Method window, Data 
Region window, Graph window and Results window. 

NOTE:  These windows can be minimized and re-opened by clicking on the minimized 
window at the bottom of the software. 
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• The Method Window shows a list of all methods of the desired type in the 
current methods directory on the hard disk. If All methods is selected for 
the Method type, the Methods window displays the method name, the 
method type and the method comment, otherwise only the method name and 
the method comment are shown. To start a method, double-click on a 
method filename. Working with application methods is described in detail in 
Working with Application Methods starting on page 67. 

 
• The Data Region Window shows a list of all the files in the data region. The 

data region is the temporary memory area for spectra, results tables, etc. 
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• The Graph Window is used to show and edit spectral curves using the View 
menu commands. The graph window Graph1 appears automatically when 
the software is started.  To display another graph window, select New Graph 
Window from the View menu.  Viewing data is described in detail starting 
on page 72. 

 
• The Results Window is a part of the application window. It appears 

automatically when you select the List or Peak commands.  The window 
displays numerical results in a table. You can copy these results to other 
programs via the Windows clipboard, select the text you want to copy and in 
the File menu, select Copy to Clipboard.   
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Exiting FL WinLab 

 From the File menu, select Exit.  

NOTE:  Applications programs are not automatically shut down when you exit FL 
WinLab Software. 
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Macro Commands 

The FL WinLab applications support a set of macro commands. The macro 
commands can be defined in a corresponding ini file (for example, Scan: 
PEBFScan.ini). All applications support the following macro hooks:  
 

OnAppStart  OnMethodStart 
OnAppEnd  OnMethodEnd 

To define a macro, the commands must be entered in the relevant ini file (for 
example PEBFScan.ini) under the appropriate topic.  For example, the following 
macro: 
 

[OnAppStart] 
Name=Calculator 
SHELL:Calc.exe 

automatically starts the Windows calculator each time the Scan is started. Any 
Name can be used for the macro, but it must be unique for the application (for 
example, you could not also use Calculator as Name for the OnAppEnd macro). 

It is also possible to use key words within macros for example: 
 
[OnAppStart] 
Name=Start Calculator 
SHELL:Uvappla.exe 
WAIT:2000 
 
[OnMethodEnd] 
Name=Calc Area 
DDE:uvappla.exe|System|0;1;<ResultFilename>;NO;NO; 
OFF;NO;OFF;NO;NO;350;400  

In this example the arithmetic calculator is started when the scan is started. 
When a method is finished the calculator is invoked to calculate the area of the 
dataset. The keyword <ResultFilename> is replaced by the name of the current 
dataset. 
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Available macro commands 

The following macro commands are currently supported: 

Spectrometer 
 

INST:<DIPCommand>  

<DIPCommand>=Any valid DIP-command for the spectrometer. To obtain the 
list of valid DIP commands, open the instrument server by double-clicking on its 
icon in the task bar. Then select Print available commands. Enter the name of 
the file you want to store the command list in (for example LamdaCmd.txt), in 
the appearing textbox and click OK. All available commands are now printed to 
the given file. The file is an ASCII file and can be opened using any text editor. 

Windows Shell 
 

SHELL:<Command> 

<Command>=Any valid command for the Windows shell. Typically it has the 
structure “Exe-Filename CommandLine”, for example “c:\Notepad c:\Test.txt” 
or “Excel text.xls”. The second example automatically starts Excel and loads 
test.xls. 

Miscellaneous 
 

MSGBOX:<Text> 

Displays the given text in a message box. The execution of the program is 
interrupted until you click OK. 
 

WAIT:<Time> 

Waits until the given time has passed, then continues execution of program. 
<Time> is the time to wait in seconds for example (5 or 3.5). 
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DDE 
 

DDE:<Server>|<Topic>|<Cmd>  

Sends the command to the given server. For available topics and commands 
please refer to the manual of the DDE-server. Note that you need to start the 
DDE server using the shell program, before you can send DDE commands. 

All applications 

The following key words are currently supported by all applications: 
 

<MethodName> 

Contains the name of the currently used method. 
 

<ResultFilename>  

Contains the full name of the current result file/dataset. 
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Application Quick Summary 

The following table gives an overview of which accessories and software 
modules are necessary for several typical applications: 

 

User's 
application 

Application Calibration 
module 

Accessory Accy/config. 

Kinetics,  
single cuvette 

TimeDrive Slope by Data 
Calculator, 
Enzyme 
activity* 

Biokinetics Stirrer 

Kinetics,  
stopped-flow 

TimeDrive Slope by Data 
Calculator 

Stopped flow 
device 

 

Kinetics, 4 
cuvettes 
simultaneously 

Wavelength 
Program 

Slope by Data 
Calculator, 
Enzyme 
activity* 

4-cellchanger Stirrer, 
Calibration for 
sensitivity 
differences 

Kinetics, 
multiple 
wavelengths, 
single cuvette 

Wavelength 
Program 

Slope by Data 
Calculator, 
Enzyme 
activity* 

Biokinetics Stirrer 

Kinetics with  
2 wavelengths 
&  
4 cuvettes 

Wavelength 
program 

Data 
calculator, 
ICBC 
Calibration 

4-cellchanger Stirrer, 
Calibration for 
sensitivity 
differences 

Luminescence  
kinetics 

TimeDrive Slope/peak 
area by Data 
Calculator 

Biokinetics, 
TEM 

Luminescence 
mode, stirrer 

Emission 
correction  
with tungsten 
lamp 

Scan Data 
Calculator 

any Luminescence 
mode 
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User's 
application 

Application Calibration 
module 

Accessory Accy/config. 

Intracellular ion 
concentration  
(Medium 
speed) 

Ratio data 
collection 

ICBC 
calibration 

Biokinetics, 
coverslip accy

Stirrer 

Intracellular ion 
concentration 
(Fast) 

Ratio data 
collection 

ICBC 
calibration 

Biokinetics, 
coverslip accy

Stirrer 

Intracellular ion 
concentration  
(Fast filter) 

Fast Filter 
application 

ICBC 
calibration 

Biokinetics, 
coverslip accy

Stirrer 

Static 
polarization 
measurements 

Read  polarizers, 
biokinetic 

Stirrer 

Rapid 
polarization 
measurements 

Fast Filter 
application 

 polarizers, 
biokinetic 

Stirrer 

Automatic 
polarization/ 
anisotropy vs. 
temperature  

Autopole*  polarizers, 
single stirrer 

n/a 

Kinetics, plate 
reader 

Well Plate 
Reader 

Kinetic 
module* 

Plate Reader n/a 

3D spectra 
(EEM) 

Scan 3D View any  

3D kinetic 
spectra 

Scan 3D View any  

3D assorted 
spectra 

Scan 3D View any  



FL WinLab Software User’s Guide 

28 

User's 
application 

Application Calibration 
module 

Accessory Accy/config. 

Simple 
intensity 
measurement 

Read  any cellholder  

Simple 
quantitation 

Concentration  any cellholder, 
sipper 

 

3D Scanning 
TLC 
plates/gels/flat 
samples 

TLC scan 3D View Plate reader n/a 

Routine testing 
of the 
instrument's 
performance 

Validate 
instrument 

 Sealed water 
cuvette 

n/a 

Protein 
unfolding 

TimeDrive; 
Autopole* 

 Single stirrer Stirrer 

Microsphere 
measurement 

WPRScan*  Plate reader  

Multiple dye 
D.N.A. 
quantitation 

WPRScan*  Plate reader  

 
* These applications are available from BioLight Ltd. (www.biolight.com). 

NOTE:  Items in italics are not compatible with the LS 45. 
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Configuring the software 

FL WinLab can be configured for different users or different projects.  

You can set or modify the following parameters: Data and methods directories, 
analyst name, default data save format, Expert/GLP mode, autorun methods 
option, the assignment of the function keys F8-F12 and the application toolbar.  

NOTE: For each configuration a separate FL WinLab icon can be created by copying 
the shortcut and changing the command line to include the path to the 
configuration file. 

Creating a configuration 

1. On the Utilities menu, select Configuration. 
The Configuration dialog is displayed. 
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2. Enter the desired configuration parameters. 
 

Parameter Description 

Methods 
Directory 

The software uses this directory as the default directory to store 
and retrieve methods.  

NOTE:  The directory must already exist, it will not be created 
automatically. 

Data 
Directory 

The software uses this directory as the default directory to store 
and retrieve data and results.  

NOTE:  The directory must already exist, it will not be created 
automatically. 

Analyst name 
 

This name will be used by all software modules (Scan, 
TimeDrive) and stored in data sets. 

Default 
spectral 
format 

Defines the format of the data files. All data acquisition 
modules (like Scan or TimeDrive) will save the collected data 
in this format. Three formats are available:  

Binary: This is the standard PerkinElmer format. It contains the 
complete dataset header information set like creation time, 
analyst and instrument parameters. Since it needs the least disk 
space, and guarantees storage of collection parameters, we 
recommend you use this format, especially for acquisition 
modules with high data throughput like FFA. 

ASCII: This format is convenient for exporting data to generic 
programs like Microsoft Excel. The ASCII format contains the 
complete dataset header information set. The main drawback is 
the large amount of disk space required. 

Data Manager: This is the old PerkinElmer FLDM format.   
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Parameter Description 

Expert mode If this option is selected all application programs are started in 
Expert mode. Otherwise they are started in GLP Mode. For 
more information, see GLP/Expert mode on page 65. 

NOTE:  Application programs do not automatically detect a 
change in the mode. That is, an application program started in 
expert mode stays in expert mode until it is terminated and 
restarted. 

Auto run 
methods 

If this option is selected, double-clicking on a method name in 
the method window loads the method into the corresponding 
application program and then automatically starts the data 
acquisition. If the option is unselected the method is only 
loaded, allowing for modifications before the data acquisition 
is started. 

Function 
Keys 

Here methods can be assigned to the function keys F8 to F12, 
so that when the function key is pressed, the corresponding 
application program is started. Then the method is loaded and, 
if Auto run methods is selected, the method is started. 

NOTE:  Starting an application program from the applications 
toolbar or applications menu does not start data acquisition, 
independent of the setting of this option. 

Toolbar Here the application toolbar can be customized. Click on one of 
the nine available buttons to start the Toolbar Configuration 
dialog, as described on page 34. 

Load Click on this button to load a personal configuration from a 
configuration file. 

Save Click on this button to save the current configuration to a 
configuration file. These configuration files can be used to start 
FL WinLab with a personal configuration. 

3. Click Save. 
The Save dialog is displayed. 
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4. Enter a filename with a .cfg file extension and click OK. 
The configuration is saved as a .cfg file. 

Customizing the Toolbar 

You can customize the Application Toolbar for each user. Proceed as follows: 

1. From the Utilities menu, select Configuration. 

2. Click on one of the Toolbar positions.  
The Toolbar Configuration dialog is displayed. 

 

3. Make the changes required: 

• Select Empty to clear the selected position of the toolbar. 

• Select one of the standard application icons to assign a standard application 
to the selected position of the toolbar. 

• Select one of the three icons to assign a user defined application to the 
selected position of the toolbar.  

• Enter the command line to invoke the application. The first part of the 
command is interpreted as the name of the application to start. (It may be 
necessary to add the complete path to the exe file name). The second part 
(delimited by a blank) is passed as command line to the called application. 

For example, the text c:\programs\notepad.exe DNAdata1.xls will call 
Notepad and automatically load the Plate Reader application results file 
DNAdata1.wpr. 
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4. Click OK.  
The Configuration dialog is displayed and shows the required change in the 
Toolbar section. 

5. Click Save to save the configuration. 

6. Click OK to leave the Configuration Dialog. 
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Status Application 

The instrument Status Application supplements the other application programs, 
for example Scan and TimeDrive and is used to specify non- application specific 
instrument parameters, for example the luminescence mode (fluorescence, 
phosphorescence, bioluminescence), filter, photomultiplier voltage, etc.  

The instrument Status Application displays a schematic of the instrument optical 
system with icons representing the individual components and the current setup 
of the instrument. This allows for a quick overview of the instrument status.  

If you are operating your system in Expert mode it is possible to set up 
instrument parameters by clicking on the icon relating to that part of the optical 
system.  In GLP mode, the instrument Status application is locked, so no 
parameters can be changed (this is done for method security).  

Parameters specified in the instrument Status Application are saved in the 
method files of the other applications as a configuration section. 

Starting the Application 

 In the Application menu select Instrument Status.  
The instrument Status graphic is displayed: 

 



FL WinLab Software User’s Guide 

40 

The page displays a schematic of the instrument optical system with icons 
representing the individual components. The current status of the instrument is 
described by the text next to the icons. The instrument type, the firmware 
revision and the serial number of the instrument are also displayed. The colors of 
the beams between each icon in the optical schematic are an approximate 
indication of the wavelength. 

In Expert Mode the setup of the instrument can be modified by clicking on the 
related icon. Changing the instrument parameters is described in detail in the 
following chapters. 
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Selecting Instrument Settings 

If you are operating your system in Expert Mode, you can use the Status page 
for setting the instrument parameters, but in GLP mode this option is not 
available.  

1. From the Application menu, select Instrument Status.  
The Status page is displayed. 

 

2. Click on the part of the optical system you want to change settings for.  
A specific configuration dialog is displayed. 

3. Make the required changes and then click OK. 
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Source options 

 

Fluorescence 

Fluorescence emission is a short-lived process that usually occurs within 10-9 to 
10-7 seconds of light being absorbed by the sample.  When operating in the 
fluorescence mode, two gating periods occur.  During the first gating the 
instrument integrates the excitation and emission photomultiplier signals at the 
instant of the flash of light. This is followed by a second gating period, which 
occurs shortly before the next flash and integrates the dark current signal (the 
signal produced when no light is falling on the photomultiplier).  The value 
obtained from the second gating is subtracted from that obtained from the first 
gating to produce a number that represents the signal free from dark current 
contribution and any long-lived luminescence emission. 

Phosphorescence  

Phosphorescence emission has a longer decay time than fluorescence emission, 
having a decay time between 10-6 s to several seconds after excitation depending 
on the sample.   

During a phosphorescence measurement, the integration time of the 
photomultiplier signal (Gate Time) begins after a user-defined Delay Time, so 
that the emission being measured does not coincide with the flash of the source. 
This short delay (use at least 0.03 ms) means that short-lived fluorescence, 
scattered light and background fluorescence are ignored. 
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Each cycle can have more than one flash. This is used to increase the efficiency 
of excitation if long cycle times are used. If multiple flashes (Flash Count>1) are 
used, then the time between the flashes is always 1 mains cycle (20 ms for 50 Hz 
mains supply).  

For example, using a cycle time of 200 ms with Flash Count=5 means that the 
lamp will be pulsed five times very rapidly, followed by 100 ms of measurement 
window for long-lived phosphorescence species, for example. Note that 
scanning of spectra is not allowed if the cycle time exceeds 200 ms. 

In phosphorescence mode the dark current signal is measured once and 
subtracted from all of the following sample and reference signals.  Whenever the 
gate time or photomultiplier voltage are changed a new dark current signal 
should be measured. 

Bioluminescence 

When the instrument is operating in bioluminescence mode the source is 
switched off and the signal is measured directly from the sample 
photomultiplier. There is no ratioing against the reference detector. Since light is 
emitted from a bioluminescent sample continuously, the setting of the gate time 
has a direct effect on signal size. For a 200 ms cycle time, a gate time of 180 ms 
would be used to obtain the best sensitivity. Using the default conditions of 
cycle time 20 ms and gate time 1 ms will lead to the integration of only 1/20th of 
light emitted by the sample. 

In bioluminescence mode the dark current signal is measured once and 
subtracted from all of the following sample and reference signals.  Whenever the 
gate time or photomultiplier voltage are changed a new dark current signal 
should be measured. 
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Option Description 

Luminescence 
Mode 

The three options are: fluor (fluorescence), phos 
(phosphorescence) and biolum (bioluminescence), as 
discussed above. 

NOTE:  The lamp and luminescence mode are set 
immediately when the related button is clicked. They are not 
reset when the dialog is exited by clicking Cancel. If 
phosphorescence or bioluminescence mode is selected, other 
options (delay time, gate time, flash count, cycle time, and 
dark current subtraction) become visible. 

Delay Time The Delay Time is the time from the beginning of the flash to 
the beginning of the integration time of the photomultiplier 
signal. Using a delay time of more than 0.03 ms will ensure 
that all short-lived fluorescence, background and scattered 
light will be ignored. 

Gate Time The Gate Time is the time over which the signals from the 
sample and reference photomultipliers are integrated, and is 
equivalent to the measurement time window. The width of 
this window directly controls the signal size. 

Flash Count The Flash Count is the number of flashes in a cycle. 
To optimize the sample excitation and data collection, it is 
possible to select up to 10 excitation pulses at the start of a 
run.  The delay and integration times then relate to the start of 
the last excitation flash. If, for example, a Flash Count of 
three is entered, with a cycle time of 100 ms, then every 0.1 
seconds there will be 3 pulses, 20 ms apart. 
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Option Description 

Cycle Time The Cycle Time sets the time between flash cycles and 
combines the flash count, delay time and integration time. It 
must be a multiple of 1/Mains frequency (20 ms at 50 Hz, 
16.66 ms at 60 Hz) and it must follow the following equation: 

cycle time > (flash count ⋅ 20 ms) + delay time + integr. time − 
12.99 ms 

If the sum of the delay and integration times is greater than 
12.99 ms, then the cycle time must be greater than 20 ms to 
make a longer data collection time possible. 

Measure and 
Set Dark 
Current 

The dark current is the signal produced when no light falls on 
the photomultiplier. In fluorescence mode the dark current 
signal is measured automatically for every flash of the lamp. 
In phosphorescence and bioluminescence modes the dark 
current signal is measured only once and then subtracted from 
all subsequent sample and reference signals.  

Varying the gate time or the photomultiplier voltage will vary 
the size of the signal that is measured. Whenever the gate 
time or the photomultiplier voltage are changed a new dark 
current signal should be measured. Please note that clicking 
on the Measure and set dark current button automatically sets 
the delay time, gate time, flash count and cycle time to the 
values given in the dialog. 

Source Click on this button to turn the source on or off.  By turning 
off the source during long periods of time between runs, the 
sample is protected from any possible photochemical 
degradation. The life of the source is also increased. 
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Option Description 

Excitation 
Correction 

Excitation correction is used to remove instrument artifacts 
(for example wavelength dependency of the intensity of the 
source) from an excitation spectrum.  This ensures that the 
shape of an excitation spectrum closely matches that of the 
absorption spectrum of a sample. FL WinLab offers three 
options: 

Off -No excitation correction is performed. 

On - The instrument automatically produces corrected 
excitation spectra using an internally stored correction curve 
generated from a rhodamine 101-quantum counter.  

File - A corrected excitation spectrum is recorded by the user 
and applied via software, not applied on-board as in the On 
option above. Enter the name of the curve to be used for 
excitation correction in the textbox or double-click on the 
textbox to select it directly from the FL WinLab directory.  

NOTE:  The spectrum must cover the whole excitation range 
(200 nm-800 nm), it must be located in the FL WinLab 
directory (not in the data directory), and that the file 
extension must be .cor.  

FL WinLab provides an example spectrum, ex.cor. If the 
excitation correction spectrum was generated using a 
quantum counter with narrower spectral range than the 
required full range, then the spectrum must be extrapolated to 
cover the entire region. 
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Excitation and Emission Monochromators  

 
 

Option Description 

Excitation 
wavelength 

Enter the required excitation wavelength, in nm. 

Emission 
wavelength 

Enter the required emission wavelength, in nm. 

Excitation 
slit 

The excitation slit width is the spectral bandwidth of the 
excitation monochromator. On an LS-50B or LS 55, you can 
select the required slit width for the excitation monochromator. 
On the LS 45, this is fixed. 

Emission 
slit 

The emission slit width is the spectral bandwidth of the emission 
monochromator. On an LS-50B or LS 55, you can select the 
required slit width for the emission monochromator. On the LS 
45, this is fixed 

Emission 
filter wheel 

If the instrument has a filter wheel fitted in the emission 
monochromator, the wheel has five cut-off filters (these transmit 
light above the stated wavelength and block off light below), a 
1% transmission attenuator, and an open and a closed position. 
The emission filter wheel is not fitted to the LS 45. 
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Option Description 

Total 
Emission 

This option is only visible if the total emission mirror (TEM) is 
fitted inside the instrument. The total emission accessory is a 
plane mirror that can be moved in place of the emission grating 
and is used to collect the entire spectrum of light from the 
sample. This increases the sensitivity by up to 20 times and is 
especially recommended for bioluminescence measurements. 
You can select the required position of the total emission mirror. 

The Total Emission accessory is used in combination with the 
emission filter wheel and large slit widths for optimal sensitivity. 
When the mirror is in the beam the emission grating is 
automatically moved out of the way. 

 

 
CAUTION 

Danger of damaging the sample photomultiplier 

If you set the total emission mirror into the beam when the emission 
filter wheel is in the open position, the high intensity of light produced 
can damage the sample photomultiplier. The software will display a 
warning message.  

For the LS 45, a 50 mm2 cut-off filter must be manually inserted into 
the right-hand sample area filter bracket. 
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Excitation and Emission Filter Wheels  

NOTE:  Not applicable to the LS 45 

Clicking on the icons for the excitation and emission filter wheels enables you to 
set the parameters for the Ex. Polarizers / Ex. Filter wheels, Fast Filter 
Accessory and Em. Polarizers / Em. Filter wheels, depending on which are 
fitted. 

The filter wheels are situated in the excitation beam between the excitation 
monochromator and sample and in the emission beam between the sample and 
emission monochromator. 

The type of excitation and emission filter wheel icons in the schematic of the 
instrument optical system depend on which accessory is fitted in the current 
configuration file/ instrument. There are three possibilities: 

 

 
Excitation filter 

wheel only 

The excitation filter wheel has an open and a closed 
position, two positions for vertical and horizontal 
polarization filters, three positions for the addition of 
custom filters, and a reserved position for an automatic 
350 nm cut-off filter. 

 
Excitation and 

emission polarizers 

Fluorescence polarization is used to study the rotational 
movement of small molecules in solution or suspension. 
For example the technique is used to measure the binding 
of coenzymes to proteins, in the study of antigen-antibody 
reactions, in determining low molecular weight haptens, 
and to measure cell membrane fluidity. 

 

Fast filter 
accessory 

The Fast Filter accessory is used for the rapid dynamic 
measurement of intracellular ion concentrations. Specific 
fluorescent dyes are used and these chelate with, for 
example, Ca2+ or H+, to give characteristic excitation and 
emission spectral shifts. 

Filters of appropriate wavelength are rapidly rotated in the 
excitation or emission beam, synchronized with the lamp 
pulsing, and at 50 Hz ratio measurements can be made 
every 40 ms.  
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Fast polarization changes can also be measured with the 
fast filter accessory by using two filter pairs with vertical 
and horizontal polarization filters in each of the beams.  It 
is also possible to use the standard emission filter wheel in 
conjunction with the accessory. 
The Fast Filter can also be used for normal analytical runs. 

NOTE:  The excitation filter wheel must be physically 
removed when the excitation fast filter is fitted. 

Excitation Filter Wheel Parameter 
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Option Description 

Filter 
Control  

The excitation filter wheel has an open and a closed position, 
two positions for vertical and horizontal polarization filters, three 
positions for the addition of custom filters and a reserved 
position for an automatic 350 nm cut-off filter. 

The 350 nm cut-off filter is automatically brought into the 
excitation beam when the excitation monochromator exceeds a 
wavelength of 410 nm.  This eliminates second order light 
reaching the sample when exciting at long wavelengths with 
narrow slit widths.  For example when exciting at 500 nm, sharp 
peaks from the source spectrum at around 250 nm are also 
present as second order artifacts.  These can affect the shape of 
the excitation spectrum, particularly when the second order light 
at 250 nm is detected by the reference detector but not absorbed 
by the sample.  The names of the filters are determined in the .ini 
file in the FL WinLab directory. 

Polarizer Parameters 
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Option Description 

Excitation 
Polarizer 

Select one of the filter wheel positions in the list. The names of 
the filters are determined in the .ini file in the FL WinLab 
directory. 

Emission 
Polarizer 

The filter wheel for the emission polarizer has a vertical and a 
horizontal polarizer, an open and a closed position and four 
positions for the addition of custom filters. The names of the 
filters are determined in the .ini file in the FL WinLab directory. 

Fast Filter Accessory (FFA) Parameters 

 

The Setup FFA Configuration dialog is divided into two sections. The left 
section contains a diagram representing the front view of the excitation fast filter 
wheel and the right section contains a diagram representing the front view of the 
emission fast filter wheel. 

For each filter pair the wavelengths, positions of the installed filters and name of 
the probe used in the application can be saved here. 
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Define the wavelengths for excitation and emission filters in these textboxes.  
Each fast filter consists of two filter pairs. The filter pairs are color-coded and 
numbered.  The numbers 1,3 and 2,4 correspond to each of the two filter pairs in 
the excitation and emission beams, respectively.  For each filter pair there is a 
text box in which the name of the appropriate probe can be indicated (for 
example probe FURA-2 uses filter pair 1,3 in excitation beam with filters of 410 
nm and 450 nm). 

It is also possible to use the fast filter accessory with vertical and horizontal 
polarization filters in each of the beams. In this case, enter V and H in the 
appropriate boxes, instead of wavelengths. 

NOTE:  The entries are used for documentation by other applications.  Since they cannot 
be checked automatically, wrong entries will lead to wrong information in 
datasets or the use of the wrong filters for data collection. 

NOTE:  The positions of the filters are predefined: for ratio measurements, the top 
intensity for the ratio (for example, the 410 nm filter for FURA-2 analysis) must 
be located in position 1 or in position 2.  Similarly, the vertical polarizer must be 
located in position 1 or position 2.  Positions 1 and 2 for the excitation fast filter 
wheel are the two top positions: for the emission fast filter wheel these are the 
bottom two positions. 

The definitions are stored when you click OK. 

 To set the Fast Filter to a static position, double-click on one of the position 
numbers 1-4.   
The background of the appropriate wavelength textbox becomes yellow.  

 To set the Fast Filter to the clear beam position, that is remove any static 
filters from the beam and stop a currently running filter wheel, double-click 
on the circular hub image in the middle.  
The backgrounds of all wavelength textboxes become white. 

NOTE:  The position of the excitation and emission filter can be set independently.  

NOTE:  The filter positions are actually set when OK is clicked. 
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Sampling Accessories  

NOTE:  Not applicable to the LS 45. 

The icon displayed in the optical schematic depends on the currently installed 
accessory. The options are: 

 

Option Description 

 
Single position cell holder (no control functions). 

 

Single position stirred cell holder. 

 
Biokinetics accessory. 

 
4-position stirred cell changer. 

 
Sipper. 

 
Well plate reader. 
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Single Position Stirrer Parameter 

 
 

Option Description 

Stirrer Select one of the three stirrer speeds. Select the low stirrer speed 
for keeping cells in suspension and for biochemical reactions, 
and high stirrer speed for rapid mixing. 

NOTE:  Selecting a speed immediately sets the stirrer speed in 
the instrument. 

Biokinetics Accessory Parameters 
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This dialog can be used to determine the temperature calibration factor for the 
biokinetics accessory. 

The temperature sensor can be calibrated so that during a run the temperature of 
the sample itself is displayed rather than the block temperature.   The block 
temperature is the temperature of the cellholder block in the biokinetics 
accessory (the maximum readable temperature is 100 °C).  The temperature of 
the sample may be different from the block temperature, but it can be calculated 
from the block temperature using the temperature factor: 

1. Enter the ambient temperature around the cell holder in °C, Ambient 
Temp. (C).  

2. Use the water bath to heat the cuvette(s) to the highest temperature you 
intend to be used.  Then, measure the temperature in the cuvette using a 
temperature measuring device with small thermal mass. 

3. Enter the temperature within the cuvette in °C, Sample Temp. (C). 

4. Click Calculate.   
The instrument now measures the block temperature, Block Temp. (C), and 
uses it to calculate a value for the Temp. Factor using the following 
equation: 

AB

Bs

TT
TTF

−
−

=  

Where: F  = Temp. Factor, Ts = Sample Temp., TB  = Block Temp.,  
TA  = Ambient Temperature 

NOTE:  If a temperature sensor has already been calibrated, then the previously 
determined temperature correction factor can be used. Simply enter the Temp. 
Factor determined for your measurement. 
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4-Position Stirred Cell Changer Parameters 

 
 

Option Description 

Stirrer Select one of the three stirrer speeds. Select the low stirrer speed 
for cell suspensions and biochemical reactions and high stirrer 
speed for rapid mixing.  

NOTE:  Selecting a speed immediately sets the stirrer speed in 
the instrument. 

Initialize Click this button to initialize and set the 4-position cell changer 
to Position 1. 

1, 2, 3, 4 Use to select a cuvette position. 

Use Calib If this checkbox is selected, the calibration factors are 
automatically used in all other applications where the 4-position 
cellchanger is used. To indicate that the use of the factors has 
been activated, the color of the factors changes from gray to 
black. 

Calibrate Starts a calibration as detailed below 

Calibrate is used to start a calibration. This is used to correct for variations in 
sensitivity between the positions of the cell changer, which can occur if one or 
more positions become scratched or corroded. 
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1. Place a standard sample in the first cuvette position. 

2. Click Read position 1.  
The Intensity is reported for the first cuvette.  

3. Repeat this for cuvette positions 2 to 4. 
Each time inserting the standard in exactly the same orientation to the 
excitation and emission light beams (this is particularly important when 
using solid standards which may not be homogeneous with respect to 
distribution of fluorescence within the solid block). 

4. When all four cuvette positions have been measured, one cuvette position 
can be used for standardization.  Select the required number in 
Standardize on position.   
The factor for each cuvette position is then calculated using the following 
equation: 

Factor(cuvette) = Intensity(cuvette) / Intensity(standard cuvette) 

5. Click OK. 
The factors are saved to a file and will be used when Use Calib is selected. 
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Sipper Parameters 

 
 

Option Description 

Pump Time The pump time is the time (in seconds) that the system pumps to 
fill the flowcell with the sample. 

Pump 
Forwards 

Select the forwards pump direction to pump the sample to the 
waste. 

Pump 
Reverse 

Select the reverse pump direction to return the sample to the 
tube. 

Sip Click to operate the sipper for the time that was specified for 
Pump Time.  To stop the sipper before the end of the indicated 
pump time, click Stop. 
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Well Plate Reader Parameters 

 

This dialog enables you to set the position of the well plate reader (WPR) to any 
X,Y position inside the allowed physical range, to send it to Park position, or to 
reset it by clicking Datum. It does not support plate formats. To use plate 
formats use the Well Plate Reader application. However, this function is useful 
for driving the Plate reader to a specified point on a flat sample where a 
spectrum or other data type can be collected. 

 To move the WPR to a specific position, click on the image of the plate in 
the  required position. 
The current X and Y coordinates of the WPR are displayed in mm. 

 Click Park to send the plate reader accessory to the park position.  
It is recommended that plates are inserted or removed only with the 
accessory in this position to avoid spillage of plate contents. 

 Click Datum to reset the plate reader accessory and send it to the 0,0 
position.  
This should correspond to the extreme corner of the plate nearest the A1 
position. 
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Detector Parameters 

Use the Detector icon to select the parameters for the installed detector.  
Different photomultiplier types are used depending on the spectral range. 
For long wavelength emissions, that is for wavelengths longer than 650 nm, a 
red-sensitive photomultiplier should be used, for example, the R928. 

 
 

Option Description 

Photomultiplier 
Type 

Select the detector to be used. The selected detector model is 
recognizable by the base color of the photomultiplier icon. A 
standard photomultiplier has a blue base, a red-sensitive 
photomultiplier has a green base. 

NOTE:  The photomultiplier must be physically changed. 
This function is only a graphical comment to remind the user 
of which detector is fitted. 

Photomultiplier 
Voltage 

The photomultiplier voltage determines the sensitivity of the 
measurement.  

If Auto is selected, the photomultiplier voltage is 
automatically selected by the instrument and is a function of 
the slit width of the excitation monochromator. 
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Option Description 

Emission 
Correction 

Emission correction is used to remove instrument artifacts 
(for example wavelength dependency of the detector) from 
an emission spectrum.  The emission correction can be used 
to normalize the spectral characteristics of different 
instruments or to compare emission spectra from the 
instrument with different types of instrument, or with spectra 
in the literature.  FL WinLab offers two options: 

Off - No emission correction is performed 

File - All emission data are corrected using a user defined 
correction curve. Enter the name of the curve to be used for 
emission correction in the textbox or double-click on the 
textbox to select it directly from the FL WinLab directory.  

NOTE:  The spectrum must cover the whole emission range 
(200 nm-900 nm), it must be located in the FL WinLab 
directory (not in the data directory), and the file extension 
must be .cor.  

FL WinLab provides two example spectra: em.cor for a 
standard detector and emred.cor for a red-sensitive detector. 
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Application Methods 

Measurements in FL WinLab are made with application methods. A method is a 
set of parameters that completely define the measurement conditions.   

A method is a set of parameters for an application. Since applications like 
TimeDrive only control part of the instrument parameters (wavelengths, slits, 
etc.), it can be desirable to send an initial setup (for example, a filter wheel 
position) to the spectrometer before any measurement is started.  Therefore each 
method contains a separate section with the parameters for the initial setup, 
besides the section for method specific parameters (for example, the data 
interval).  
FL WinLab can be operated in two modes, which differ mainly in the way this 
initial setup is handled: GLP mode and Expert mode. 

GLP/Expert mode 

NOTE:  GLP/Expert mode is selected on the Configuration dialog, see Configuring the 
software starting on page 31.  

In Expert mode, the parameters of the initial setup section of a method are sent 
to the instrument each time a method is loaded. Now the Setup program can be 
used to modify the instrument configuration. When a measurement is started 
only the method specific parameters are sent to the instrument. This allows the 
expert user to repeat the measurement by toggling to the Setup program and 
manually changing the instrument configuration. When the method is eventually 
saved, the setup section of the method is updated with the current instrument 
configuration. 

In contrast to the Expert mode, it is not possible to modify the initial setup 
parameters in GLP mode. The Setup program only displays the current 
instrument configuration, all dialogs are disabled. The instrument is set to the 
parameters of the initial setup section every time a measurement is started, 
before the method specific parameters are sent. Since all applications lock the 
instrument during a data acquisition, so that no other application can send a 
command to the instrument, it is guaranteed that all measurements are performed 
with exactly the same instrument setup. If a method is modified and saved under 
a different name the initial setup section of the original method is copied. 
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In Expert mode it is possible to lock or unlock methods. If a method is locked, 
all entry fields and the command method save are disabled.  The method 
parameters cannot be modified. Since it is not possible to unlock the method in 
GLP mode this guarantees a defined measurement. 

It is recommended that you generally work in GLP mode and change to Expert 
mode only if new methods are to be optimized or generated. The example 
methods, distributed with FL WinLab, contain default setup sections. 

The mode can be set in the instrument Configuration dialog, and can be different 
for each user. The current mode is displayed in the status bar along the bottom of 
each FL WinLab application.  

NOTE:  The initial setup section does not contain the settings of the monochromators 
and slits. This avoids unnecessary overhead since these parameters are 
controlled directly by every application. Furthermore, the setting of certain 
accessories, like the cuvette changer position and the position of the well plate 
reader accessory, are not saved since these settings depend on the sample or 
sampling sequence. 
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Working with Application Methods 

Opening an application method 

1. To open a method, select Method Open from the File menu. 
The method open dialog appears: 

 

2. Select the required method, and then click Open.  
In Expert mode loading a method sets up the parameters for the application 
(immediately, and only once) and data collection for this method can be 
started immediately. In GLP mode parameters are not sent immediately to 
the instrument. Instead, they are sent every time that the method is run. 

Printing an application method 

 To print out the current method, select Method Print from the File menu.  
The application will use the default Windows printer settings. 

Exiting an application 

 To close an application, select Exit from the File menu. 
If changes have been made to the method and not saved, a warning will be 
displayed, enabling you to save the changes. 

NOTE:  You cannot close an application while it is collecting data (traffic light is red) or 
while it is busy (mouse pointer has the shape of an hourglass). Stop the data 
acquisition, wait until the traffic light becomes green and then try again. 
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Saving an application method 

When an application method has been created or changed, it must be saved. 

1. Select Method Save from the File menu. 
A save dialog is displayed. 

 

2. Enter a new File name or select an existing method to over-write it.   
The file extension of .mth will be automatically added. 

NOTE:   We recommend that you save the method in the standard FL WinLab method 
directory.  

 
In Expert mode the application checks if the current instrument setup is the 
same as the instrument setup stored in the method file. If the instrument 
setup has changed the following message will appear: 

 
Click Yes to update the method with the current instrument setup 
parameters, click No to save the method with the original instrument setup 
parameters.  
In GLP mode the instrument setup parameters cannot be changed. 
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Starting/Stopping Data Collection 

The Start/Stop button has the appearance of a traffic light, which can be red, 
yellow or green. 

 

Traffic Light Meaning 

 
Yellow 

This is the status at the start of the application. It indicates that 
the application is currently initializing. If the instrument is 
offline, the traffic light stays yellow until the instrument is 
switched on. When the application is ready to start the data 
acquisition, the traffic light changes to green. 

 
Green 

When the button is clicked the instrument is setup for the 
method, the run is started and the acquired data is displayed in 
the graph window as it is collected. In Expert mode, only the 
application specific parameters are sent to the instrument (for 
example slit widths), the non-application specific instrument 
parameters (like position of emission filter) remain unchanged. 
In GLP mode all instrument parameters are set up. After data 
acquisition has been started the traffic light changes to red. 

 
Red 

If the button is clicked the run is stopped and the traffic light 
goes back to green. When the data collection is stopped, the 
data obtained up to this point is not lost but saved in the 
current FL WinLab data directory. 
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Start/stop options available when setting up 
application methods 

The following options may be available when you set up the application method. 

Remote start 

If this option was selected when the method was set up, data collection is not 
started until a contact closure is sensed between the 0VA and Remote Start 
connections on the rear panel of the instrument.  

When you click on the green traffic light and the instrument is set up, the 
following dialog is displayed until the remote start signal is sent. 

 

Keyboard start 

If this option was selected when the method was set up, after clicking on the 
green traffic light, the dialog below is displayed and data collection will not start 
until you press ENTER on the keyboard, or click OK on the dialog. 

 

Immediate start 

If this option was selected when the method was set up, when you click on the 
green traffic light the instrument is set up and then data collection begins 
immediately. 
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Show timed events 

If this option was selected when a TimeDrive method was set up, you may, for 
example mark the addition of a reagent to the sample. A timed event can be 
marked either by using the PerkinElmer Biokinetics accessory, which has an 
integrated Event Button, or by contact closure between the 0VA and Event Mark 
connections on the rear panel of the instrument. Once the data acquisition has 
been started, the data run file with the extension *.TD plus a second file using 
the same name but with the file extension *.TDE will be displayed in the View 
results page. This has a constant ordinate value of -5 except for the marked 
events, which result in a spike for each event. 
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Ways of Viewing Data 

Viewing data on-screen within an application 

All applications which display graphical data have a toolbar containing several 
graphics control buttons. These are all active during data collection (with the 
exception of the dataset delete button). During data collection, the user can for 
example rescale axes, zoom, and autoexpand for specific datasets.  

Viewing data off-line within the FL WinLab Software 

FL WinLab can be used to view data off-line, for example for the evaluation of 
previously collected data while an application is collecting new data in the 
background. There is a set of toolbar buttons that provide rapid access to a range 
of graphics rescaling and handling functions.  

Viewing data on-screen within the FL WinLab 
Software 

In addition to the off-line viewing capabilities of FL WinLab, there is another 
very useful feature: the user can load copies of data currently being collected 
into one or more view windows.  The significance of this is that current data can 
be compared to existing data or displayed in separate windows for clarity. 

An example of this is intracellular ion analysis, where the application collects 
two intensity TimeDrives and the ratio of these two in real time.  It is important 
to view all 3 datasets, to ensure that neither intensity is off-scale, and to view the 
ratio in real-time. With only one view window, it is often not possible to see all 
datasets clearly, since they have very different ordinate levels, compressing the 
ratio in comparison to the intensities: 
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By opening two view windows, the user can view the intensities clearly, and also 
view the ratio data simultaneously against a previously stored calibration dataset, 
for example: 

 

This greatly clarifies the presentation of graphical data, and assists in real-time 
diagnosis of the experiment. 

Applications where this feature is particularly significant include: 

• Wavelength Program 

• Ratio Data Collection 

• Fast Filter 
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Generic Viewing Features 

Application Toolbars 

The following tools are available for changing views of graphs. 
 

Tool Description Use 

 
Auto-
expansion 
of X-axis 

Displays the entire abscissa range of all selected data 
files. If for example you have selected two TimeDrives 
of 0-50 and 20-200 second ranges respectively, clicking 
this tool will set the abscissa range to 0 to 200. 

 
Auto-
expansion 
of Y-axis 

Displays the entire ordinate range of all selected data 
files. If for example you have selected two TimeDrives 
of 0-50 and 20-200 ordinate ranges, clicking this tool 
will set the ordinate range to 0 to 200. 

 
Format 
graph 
ranges 

Displays a window for the manual formatting of abscissa 
and ordinate ranges, as described in Formatting the 
graph on page 76. 

 
Select 
default  
Y-range 

Set the ordinate range to the values defined in ordinate 
minimum and ordinate maximum of the real-time options 
page. 

 
Radar 
Window 

Displays the radar window, which can be used to show 
any required sections of data in an enlarged format in the 
window, with the selected range shown in the green 
section. A new area can be selected by either moving the 
green section or altering its size by dragging the edges 
with mouse. 

 
Vertical 
cursor 

Activates the vertical cursor, which can be continuously 
moved with the mouse to show abscissa and ordinate 
values along with the file name in a panel at the bottom 
of the window. To deactivate the cursor, click on the 
button again. 
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Tool Description Use 

 
Delete 
Curves 

Deletes selected curves. This button is deactivated during 
data collection. 

 
Print Prints the content of the current window using the default 

Windows printer settings. 

 
Copy to 
clipboard 

Transfers a bitmap of the graph window into the 
windows clipboard for copying into word processors, 
graphics packages or spreadsheets for report generation. 

Displaying graphs 

1. Select New Graph Window from the View menu 
A new graph window is displayed.  

2. Select Add Curve from the View menu. 
A file selector is displayed, which you can use to add curves from hard 
disk, floppy disk or data region to the active graph window. 
To add a curve from the data region select the curve by clicking on the 
name.  
You can select more than one file from a list by holding the SHIFT or 
CTRL key, while clicking on filenames. 

Selecting curves on a graph 

Each curve on the graph is listed in the pane at the bottom of the graph.   

 

Curves with their names bold and underlined are currently selected. 
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1. To select or deselect a curve, click on it with the left mouse button. 
To select more than one curve either hold down the CTRL key and click on 
each unselected curve you want to select, or hold down the SHIFT key and 
click on the first and the last curve of a range of curves to be selected. 

2. To then remove the selected curves from the graph, click . 
If all the curves are not on view in the pane, you can increase the size of the 
pane by clicking on the upper border and holding down the left mouse 
button while dragging the mouse. 
The mouse pointer changes to a two-headed arrow when it is in the correct 
position for dragging. 

 

Formatting the graph  

NOTE:  During data collection manual formatting is deactivated. 

1. Select Format Graph from the View dialog. 
The Format Graph dialog is displayed. 

 

2. Select Autorange on either axis to automatically set that axis to the 
maximum range of the displayed curves when a curve is loaded, 

OR 

Define the ranges you want displayed by typing in the boxes. 
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3. Click Set Colors to select the colors for grid, background and axis from the 
Graph colors dialog.  

 
For example, to select the color for the grid, click on Grid then click on the 
color you require. 

4. Click Set Grid to switch on the vertical and horizontal grids from the Grid 
Settings dialog. 

  

5. Click OK on the Format Graph dialog. 
The graph is re-formatted as set. 

Adding text to a graph  

1. Select Add Text from the View menu. 
The Add Text dialog is displayed. 
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2. Type the text required and then click OK. 
The new text will appear in the middle of the active graph window.  

3. Move the text to the desired position by clicking on it and then holding 
down the left mouse button as you drag it to the required position. 
Releasing the mouse button sets the position of the text. 

NOTE:  To remove the text, click on it to select it and then select Remove Text from the 
View menu. 

Using Cursors 

The View menu commands Vertical Cursor Continuous, Vertical Cursor 
Peak and Horizontal Cursor toggle cursors on the graph that enable you to read 
off abscissa and ordinate values from the panel at the bottom of the window. 

 To move a cursor, move the mouse indicator onto the cursor until it takes 
the form of a double arrow, click with the left mouse button and drag the 
cursor to the desired spot.  
The continuous cursor can be positioned anywhere on the graph, while the 
peak cursor will automatically snap to the nearest peak. 

Labelling Peaks 

You can display peak labels on the maxima and minima of the selected curves in 
the active Graph window. 

1. Select Label Peaks from the View menu. 
The Find peaks dialog is displayed. 
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2. Select the required Threshold. 
This defines the sensitivity of peak detection.  If a peak height is less than 
the threshold, it is not identified as a peak and not labelled.  
The threshold is the difference in ordinate units between the peak and the 
bases on either side of it. 

3. Set the required Start wavelength and End wavelength. 
Defines the start and end of the abscissa range inside which peaks are to be 
identified and labelled. 

4. Choose whether to Label only peaks, only bases or both. 

5. Choose whether to Display the abscissa value, the ordinate value or both. 

6. Click OK. 
The peak labels are displayed. 

NOTE:  To remove peak labels, select Clear Peak Labels from the View menu. 

Viewing multiple curves 

 For a clearer view of multiple curves on a single graph, select Split from 
the View menu. 
The curves are displayed one above the other in the active Graph window. 
On deactivation, curves are again superimposed on one another. 

Zooming into a Graph 

1. To select the zoom area, click with the left mouse button on the upper left 
point and move the mouse to the lower right point, keeping the left mouse 
button pressed.  
A green rectangle appears. 
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2. To reposition or resize the green rectangle, drag the borders with the mouse 
while holding down the left mouse button. 

3. When the green rectangle is correctly positioned, double-click the left 
mouse button within the rectangle. 
The area in the rectangle is displayed filling the window. 

Viewing Dataset Status Information 

1. To view the status information related to a curve, click on the gray button 
next to the name of the curve in the pane in the bottom of the window. 
The Status Information dialog is displayed. 

 

2. To display the stored information about the instrument the spectrum was 
collected with, click Instrument.  

3. When finished, click Close. 
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Copying to Report Builder 

 Selecting Copy to Report Builder from the View menu copies the selected 
curve from the active Graph window to the Report Builder.  
Report Builder starts if it is not currently running. 

NOTE:  For more information on Report Builder, see the on-screen help file supplied 
with Report Builder, which you start by selecting Contents from the Help menu 
in Report Builder. 
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Viewing options available when setting up 
application methods  

The following options may be available when you set up the application method. 

Ordinate label 

Enables you to decide how you want the ordinate label to read. The label is 
stored in the dataset and is displayed on the ordinate axis of the graph. 

Ordinate Max and Min 

These ordinate maximum and minimum values are used as defaults for the 
ordinate range displayed in the graph when a measurement is started. If you 
leave the boxes empty the graph’s ordinate range does not change when a 
measurement is started.  

Auto-clear curves 

This option enables you to define whether previous curves will be left in the 
graph window or will be automatically deleted on starting a run. 
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Saving Results and Curves 

When you select Save As from the File menu, the format of the Save As dialog 
depends on whether the current window is a results window or a graph window. 

Results Save As Dialog  

This dialog is used to save results from a Results window in a file. 

 

 Enter a Filename and click OK. 
The results file is saved. 

Curve Save As Dialog 

This dialog is used to save curves from a Graph window in a file, or to convert 
spectral curves into another file format. 

 

1. Enter a Filename or select one to overwrite. 
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2. Select the required Filetype.  
Defines the format in which the data file is stored. Four formats are 
available: 

• Binary - This is the standard PerkinElmer format. It contains the 
complete dataset header information set like creation time, analyst 
and instrument parameters. Since it uses the least disk space it is the 
recommended format, especially for acquisition modules with high 
data throughput like FFA. 

• ASCII - This format is especially convenient when you want to 
export data to generic programs like Microsoft Excel. The ASCII 
format contains the complete dataset header information set. The 
main drawback is the large amount of disk space required. 

• Data Manager - This is the old PerkinElmer format.   

• JCAMP - The data is stored in JCAMP-DX 4.24 format. Use this 
format to transfer the data to other data processing programs. 
However, in this format the header information like instrument 
settings are not stored and the data server can recognize the JCAMP 
format only if the file extension is .dx. To re-import JCAMP data 
files it is therefore necessary to rename them with this extension. 

3. Enter any Curve info required. 

4. Click OK. 
The curve is saved in the file format specified. 

 



 

 

Arithmetic 
Application 5 
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Arithmetic  

 Select Arithmetic from the Data Handling menu. 
The Arithmetic application is displayed. 

The Arithmetic application is used for spectral manipulation, data conversion 
and comparison, and data reduction.  One Graph Window displays the original, 
unaltered spectrum whilst a second window displays the spectral or tabular 
results of the calculations. 
 

Menu Item Application 

Area To calculate the area beneath the spectral curve. 

Arithmetic Spectrum To perform mathematical operations on spectral data, 
e.g. add two spectra or multiply a spectrum by a 
factor. 

Arithmetic Value To perform mathematical operations on spectral data, 
e.g. Ratio, Difference or multiply an ordinate value 
with a factor. 

Average and Standard 
Deviation Spectrum 

To calculate the average and standard deviation from 
spectra. 

Average and Standard 
Deviation Value 

To calculate average, standard deviation, and rms at a 
specified wavelength range. 

Build Spectra Build a spectrum via input values. 

Calculate Height To calculate the total height and the height to a 
specified base.  

Convert X To convert the abscissa unit. 
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Convert Y To convert the ordinate unit. 

Derivative To calculate the first, second, third or fourth 
derivative of a spectral curve. 

Interpolate To change the data interval and to copy part of a 
spectral curve. 

Merge To merge two spectral curves. 

Normalize To normalize spectral curves to a given ordinate 
value. 

Reflection Correction To correct a reflectance spectrum for dark and white 
values. 

Selection To display ordinate values at defined abscissa values. 

Slope To calculate the slope and the standard deviation of a 
spectral curve within a selected abscissa range. For 
TimeDrive curves, also use to calculate the enzyme 
activity. 

Smooth To smooth spectral data. 

Film Thickness To calculate the film thickness of single layers. 
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Area 

Use the Area command to calculate the area beneath the spectral curve. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 
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3. Enter the from and to values for the range over which you wish to calculate 
the area. 

OR 

You may use the vertical cursor to determine the exact values. Place the 
mouse in the field whose value you want to determine e.g. from. Select 
Vertical Cursor Cont from the View menu. Use the mouse to position the 
vertical cursor at the required location. The value in the field updates to the 
position of the vertical cursor. Click the mouse outside the field to accept 
the value. 

4. If you wish to additionally calculate an area with a Baseline correction 
enter the at/from and (to) values. 
To correct for a sloping baseline enter a value in both the at/from and (to) 
fields. Either manually enter the required values or use the vertical cursor 
as described in step 3 to determine the values. 

 
To correct an offset baseline, enter a value in the at/from field and leave 
the (to) field empty. Either manually enter the required value or use the 
vertical cursor as described in step 1 to determine the value. 

5. Click Calculate. 
The calculation is performed on the spectrum/spectra displayed in the 
Graph Window and the results are displayed in the Results Window. 
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Arithmetic Spectrum 

Use the Arithmetic Spectrum command to perform mathematical operations on 
spectral data, for example, add two spectra or multiply a spectrum by a factor. 

 

 

1. Click on the left hand drop-down Dataset/Constant list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

2. Select the required spectrum. 
The spectrum is displayed in the Graph Window and the name of the 
spectrum is displayed in the Dataset/Constant field. 

NOTE:  If spectra have previously been selected, these are listed in the drop-down list 
and may be selected. 

3. Select the required Operator from the drop-down list. 

4. Click on the right hand drop-down Dataset/Constant list and select 
<disk>. 
An Open spectrum from disk, file selector is displayed. 



FL WinLab Software User’s Guide 

92 

5. Select the required spectrum. 

OR 

Instead of selecting a spectrum in step 1 or step 4 you may enter a constant 
that you wish to apply to the spectrum listed in the other Dataset/Constant 
field. 

NOTE:  At least one of the Dataset/Constant fields must contain the name of a spectrum. 
If two spectra are displayed, they must have the same abscissa units. If the 
spectra have different abscissa ranges, the calculation is only performed over 
the common range. 

6. Click Calculate. 
The calcuation is performed and the resultant spectrum is displayed in the 
Result Window. 

7. To save the resultant spectrum, ensure that the Result Window is selected 
and choose Save As from the File menu. 
The Spectra Save As dialog is displayed. The default filename of the result 
spectrum is arith**.yy, where ** is an autoincremented number and yy is 
the same file extension as the spectrum displayed in the Graph Window. 
The results are saved to the ../data directory. The ordinate unit of the 
resulting curve depends on the ordinate unit of the source data in the Graph 
Window. 

NOTE:  You may alter the automatic file name. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 
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Arithmetic Value 

Use the Arithmetic Value command to perform mathematical operations on 
spectral data, for example, Ratio, Differences or multiply an ordinate value with 
a factor. 

Up to three abscissa values and two factors, or two abscissa values and three 
factors can be used in the calculations. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 
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3. Enter the starting wavelength for the calculation in the Value 1 field. 

OR 

You may use the vertical cursor to determine the exact value.  Place the 
mouse in the Value 1 field.  Select Vertical Cursor Cont from the View 
menu. Use the mouse to position the vertical cursor at the required location. 
The value in the field updates to the position of the vertical cursor. Click 
the mouse outside the field to accept the value. 

4. Select the required Operator from the drop-down list. 

5. Enter the end wavelength for the calculation in the Value 2 field. 

OR 

You may use the vertical cursor to determine the exact value.  Place the 
mouse in the Value 2 field.  Select Vertical Cursor Cont from the View 
menu. Use the mouse to position the vertical cursor at the required location. 
The value in the field updates to the position of the vertical cursor. Click 
the mouse outside the field to accept the value. 

6. If you require a third abscissa value or a factor for the calculation, click 
Operator. 
Value 3 field is displayed. 

7. Select the required Operator from the drop-down list. 
This is the drop-down list between Value 2 and Value 3. 

8. Enter the required wavelength for the calculation, or enter the required 
Factor in the Value 3 field. 

9. If you require a Factor (or an additional factor if you have already entered 
one in Value 3 field), click Operator. 
This is the operator button directly  beneath the Result window. 
A Factor 1 field is displayed. 

10. Select the required Operator from the drop-down list. 

11. Enter the required Factor in the Factor 1 field. 
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12. If you require another Factor, click Operator. 
This is the second operator button beneath the Result window. 
A Factor 2 field is displayed. 

13. Select the required Operator from the drop-down list. 

14. Enter the required Factor in the Factor 2 field. 

15. Click Calculate. 
The calculation is performed and the results are displayed in the Result 
Window. 
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Average and Standard Deviation Spectrum 

Use the Average and Standard Deviation command to calculate the average 
spectrum and standard deviation spectrum.  A minimum of two spectra are 
required, and a maximum of 16 spectra may be used for the calculations. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectra that you wish to perform the calculations on. 
The spectra are displayed in the Graph Window. 

NOTE:  The spectra must have the same ordinate type and the same abscissa units. If the 
spectra have different abscissa ranges, the calculation is only performed over 
the common range. 
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3. Click Calculate. 
The resultant average spectrum and standard deviation spectrum are 
displayed in the Results Window. 

4. To save the resultant spectra, ensure that the Result Window is selected and 
choose Save As from the File menu. 
The Spectra Save As dialog is displayed, enabling you to save the average 
spectrum and then the standard deviation spectrum. The default filename of 
the average spectrum is aver**.yy, where ** is an autoincremented number 
and yy is the same file extension as the spectrum displayed in the Graph 
Window.  The default filename of the standard deviation spectrum is 
std**.yy. The results are saved to the ../data directory. The ordinate unit of 
the resulting curves depends on the ordinate unit of the source data in the 
Graph Window. 

NOTE:  You may alter the automatic file names. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 
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Average and Standard Deviation Value 

Use the Average and Standard Deviation Value command to calculate the 
average, standard deviation, and rms (root mean square) over a specified 
wavelength range. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectra in the list or, if the spectrum/spectra are not 
listed, click Add spectra from disk, to display a file selector. 

2. Select the required spectra that you wish to perform the calculations on. 
The spectra are displayed in the Graph Window. 
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3. Enter the from and to values for the range over which you wish to calculate 
the average, standard deviation and rms. 

OR 

You may use the vertical cursor to determine the exact values.  Place the 
mouse in the field whose value you want to determine e.g. from.  Select 
Vertical Cursor Cont from the View menu. Use the mouse to position the 
vertical cursor at the required location. The value in the field updates to the 
position of the vertical cursor. Click the mouse outside the field to accept 
the value. 

4. Enter the required Interval. 

5. Click Calculate. 
The calculations are performed for all the selected spectra and the results 
displayed in the Result Window. 
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Build Spectra 

Use the Build Spectra command to generate a synthetic spectrum. 

 

1. Enter the User ID to be stored with the spectrum. 

2. Select the required X Label (Abscissa label) from the drop-down list. 

3.  Select the required Y Label (Ordinate label) from the drop-down list. 

4. Enter the required Abscissa Start value.   
This value is incremented based on the starting wavelength and the data 
interval. 

5. Enter the required Data Interval.   

6. Enter the required Ordinate Value for the Abscissa Start value. 

7. Click Ordinate Pair. 
The Abscissa and Ordinate values are displayed in the XY Table. The 
Abscissa Start value field is now titled Asbcissa value and is automatically 
incremented. Both the Abscissa Value and Data Interval fields become 
greyed. The Data Interval is fixed at the selected value. 
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8. Enter the Ordinate Value for the given auto-incremented Abscissa Value. 

9. Click Ordinate Pair. 
The table of values is updated. 

10. Repeat steps 8 and 9 until all the required values have been entered. 

NOTE:  If an incorrect Ordinate Value has been entered, double-click on the incorrect 
value in column Y of the table; a Change Data dialog is displayed.  Enter the 
correct value and click OK.  The value in the table is updated. 

11. Click Save. 
A Save Text File dialog is displayed. 

12. Enter the name of the spectrum. 
The data is saved as a .rbs file (build spectrum).  

13. Click Build Dataset. 
The spectrum is displayed. 
The Spectra Save As dialog is displayed, enabling you to save the 
spectrum.  The default filename of the spectrum is newset**.sp, where ** is 
an autoincremented number.  The spectrum is saved to the ../data directory.  

Clicking on X or Y above the table column highlights whole column. 

Clear 

Clear removes all values in the table and re-enables the abscissa and data 
interval. 

New rows 

Click New Rows to add new blank rows to the table.  Use the Number of rows 
selector to choose the number of rows to be added.  One row contains the values 
for one data point. 

Remove rows 

Click Remove Rows to remove rows from the table.  Use the Number of rows 
selector to choose the number of rows to be removed. 

NOTE:  The rows are removed incrementally from the bottom of the table upwards. 
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Copy data 

Copy data copies selected data in the grid table to the clipboard. 
 

Paste data 

Paste data copies data from the clipboard into the table. 

NOTE:  If you wish to paste data into the table, the number of new (blank) rows must be 
at least the same as the number of rows to be pasted.  If you try to paste more 
rows than there are blank rows available, the blank rows will be filled and the 
remaining data will not be pasted into the table. 

Load 
 
Load allows you to open a previously saved method file (*.rbs).  An excel 
spread sheet can be opened if it has the formatting (Tab delimited): 
 

Number of Rows  [Tab] Start Abscissa  [Enter] 

Abscissa values   [Tab] Ordinate values  [Enter]   
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Calculate Height 

Use the Calculate Height command to calculate the total height and the height 
to a specified baseline. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum that you wish to perform the calculations on. 
The spectrum is displayed in the Graph Window. 
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3. Enter the Define Peak wavelength. 
This is the value of the peak maximum. 

OR 

You may use the vertical cursor to determine the exact value.  Place the 
mouse in the Define Peak field.  Select Vertical Cursor Cont from the 
View menu. Use the mouse to position the vertical cursor at the required 
location. The value in the field updates to the position of the vertical cursor. 
Click the mouse outside the field to accept the value. 

4. Enter the at/from and (to) values for the abscissa range over which to 
calculate the total height and the height to base.  

OR 

You may use the vertical cursor to determine the exact values.  Place the 
mouse in the field whose value you want to determine e.g. at/from.  Select 
Vertical Cursor Cont from the View menu. Use the mouse to position the 
vertical cursor at the required location. The value in the field updates to the 
position of the vertical cursor. Click the mouse outside the field to accept 
the value. 
A horizontal marker appears on the graph to show the range defined and the 
baseline that will be used to calculate the Height to Base. 

NOTE:  Instead of entering a value in the DefinePeak field you can select Automatic.  If 
you select Automatic, the software automatically searches for a peak in the 
specified baseline range.  

5. Click Calculate. 
The calculation is performed and the results are displayed in the Result 
Window. 
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Convert X 

Use the Convert X command to convert the abscissa unit. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 

3. Click the appropriate button to convert the abscissa values.  
 

nm <> cm-1 Converts the abscissa unit from nm to cm-1 and vice versa. 

cm-1 <> m 10-6 Converts the abscissa unit from cm-1 to µm and vice versa. 

sec <> min Converts the abscissa unit from sec to min and vice versa.  
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Convert Y 

Use the Convert Y command to convert the ordinate unit, for example, from 
% transmittance to absorbance, or to calculate absorptance (AP = 1 – T – R). 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 

3. Click the required button to perform the Convert Y calculation. 

%T <> A 

Converts spectral data from transmittance to absorbance (optical density) and 
vice versa. 



Arithmetic Application 

107 

%R <> KM   

Converts spectral data from reflectance to Kubelka-Munk and vice versa. 

NOTE:  The source data must have the ordinate unit %R or %T. 

Logarithm 

Calculates the logarithm of all ordinate values. The logarithms of zero and 
negative values are set to very small negative values. 

Change Y 

Changes the ordinate label with the specified label.  

 Select the required ordinate label from the drop-down list and click 
Change Y. 
The ordinate label is changed. 

NOTE:  Only ordinate labels with the same scale can be changed.  For example, it is 
possible to change %T to %R but not to A. 

Square Root 

Calculates the square root of all ordinate values. 

%R <> Log(1/R) 

Converts spectral data from reflectance to log(1/R) and vice versa. 
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Calculate Absorptance  

Absorptance spectrum  = 1 – Transmittance – Reflectance 

Transmittance = Transmission / 100 Reflectance = Reflection / 100 

1. Click on the %T drop-down list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

2. Select the required transmission spectrum. 
The spectrum is displayed in the Graph Window and the name of the 
spectrum is displayed in the %T field. 

NOTE:  If spectra have previously been selected, these are listed in the drop-down list 
and may be selected. 

3. Click on the %R drop-down list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

4. Select the required reflection spectrum. 
The spectrum is displayed in the Graph Window and the name of the 
spectrum is displayed in the Select Dataset field. 

NOTE:  If spectra have previously been selected, these are listed in the drop-down list 
and may be selected. 

5. Click Calculate Absorptance. 
The absorptance spectrum is displayed. 

6. To save the resultant spectrum, ensure that the Result Window is selected 
and choose Save As from the File menu. 
The Spectra Save As dialog is displayed. The default filename of the result 
spectrum is abs**.yy, where ** is an autoincremented number and yy is the 
same file extension as the spectrum displayed in the Graph Window. The 
results are saved to the ../data directory.  

NOTE:  You may alter the automatic file name. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 
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Derivative 

Use the Derivative command to calculate the first, second, third or fourth 
derivative of a spectral curve. 

Derivative spectra usually have sharper features than the original spectra. You 
can use the amplitudes of features in derivative spectra in the same way as peak 
absorbances. The elimination of some baseline effects in derivative spectra can 
be useful in quantitative methods. 

You can use the Derivative command to take the first, second, third or fourth 
order derivative of a spectrum. 

The first derivative removes any baseline offset and the second derivative 
removes any linear slope also. 

Second-derivative spectra have sharp minima where there are maxima in the 
original spectrum and so can be used to identify band positions in complex 
regions. 
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1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 

3. Select the Derivative Order to be applied to the spectrum/spectra from the 
drop-down list. 

4. Select the Number of points. 
The Number of points sets the number of data points used to calculate the 
derivative. As you increase the number of data points used in the 
calculation, the contributions of broader features increases relative to 
narrow features. 

5. Click Calculate. 
The calculation is performed and the derivative spectra are displayed in the 
Result Window. 

NOTE:  To help you see the details of the result spectra, they are multiplied by a scaling 
factor depending on the order of the derivative.  First order spectra are not 
scaled, second order are scaled by a factor of 10, third order by a factor of a 
hundred, and fourth order by a factor of a thousand. 

6. To save the resultant spectrum, ensure that the Result Window is selected 
and choose Save As from the File menu. 
The Spectra Save As dialog is displayed with a default filename 
(deriv**.yy, where ** is an autoincremented number and yy is the same file 
extension as the spectrum displayed in the Graph Window).  

NOTE:  You may alter the automatic file name. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 
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Interpolate 

Use the Interpolate command to change the data interval (the number of points 
that make up the spectrum) and copy all or part of a spectrum. 

Interpolation adds points to a spectrum by adding new points between the points 
that already exist. Interpolation removes points from a spectrum by selecting 
every nth point of a spectrum and removing it. 

The number of data points needed in a spectrum depends on the width of the 
features in the spectrum. If the separation of the data points is smaller than that 
needed to define the features in the spectrum, the number of points can be 
reduced without reducing the amount of information in the spectrum. 

Increasing the number of data points in a spectrum cannot increase the amount 
of information in the spectrum.  
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1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 

3. Enter the from and to values for the interpolation range. 

OR 

You may use the vertical cursor to determine the exact values.  Place the 
mouse in the field whose value you want to determine e.g. from.  Select 
Vertical Cursor Cont from the View menu. Use the mouse to position the 
vertical cursor at the required location.  The value in the field updates to the 
position of the vertical cursor.  Click the mouse outside the field to accept 
the value. 

4. Enter the required new data Interval. 

5. Click Calculate. 
The resultant spectrum or part of a spectrum is displayed in the Result 
Window. 

6. To save the resultant spectrum, ensure that the Result Window is selected 
and choose Save As from the File menu. 
The Spectra Save As dialog is displayed. The default filename of the result 
spectrum is inter**.yy, where ** is an autoincremented number and yy is 
the same file extension as the spectrum displayed in the Graph Window. 
The results are saved to the ../data directory.  

NOTE:  You may alter the automatic file name. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 
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Merge 

Use the Merge command to merge two spectral curves. 

 

1. Click on the drop-down Select Dataset 1 list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

2. Select the required spectrum. 
The spectrum is displayed in the Graph Window and the name of the 
spectrum is displayed in the Select Dataset 1 field. 

NOTE:  If spectra have previously been selected, these are listed in the drop-down list 
and may be selected. 

3. Click on the drop-down Select Dataset 2 list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

4. Select the required spectrum. 
The spectrum is displayed in the Graph Window and the name of the 
spectrum is displayed in the Select Dataset 2 field. 

NOTE:  The spectra must have the same abscissa and ordinate units. 
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5. Enter the Merge Point. 
The value will be in the same units as the two spectra displayed in the 
Graph Window. 

OR 

You may use the vertical cursor to determine the exact value.  Place the 
mouse in the Merge Point field. Select Vertical Cursor Cont from the 
View menu. Use the mouse to position the vertical cursor at the required 
location.  The value in the field updates to the position of the vertical 
cursor.  Click the mouse outside the merge Point field to accept the value. 

6. Click Calculate. 
The merged spectrum is displayed in the Result Window. 

7. To save the resultant spectrum, ensure that the Result Window is selected 
and choose Save As from the File menu. 
The Spectra Save As dialog is displayed. The default filename of the result 
spectrum is merge**.yy, where ** is an autoincremented number and yy is 
the same file extension as the spectrum displayed in the Graph Window. 
The results are saved to the ../data directory.  

NOTE:  You may alter the automatic file name. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 
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Normalize 

Use the Normalize command to normalize spectral curves to a given ordinate 
value. Normalize can be used to set a common peak in several spectra to the 
same ordinate limit. The source data are multiplied by a factor to match the 
ordinate value at the selected abscissa position. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum that you wish to perform the calculations on. 
The spectrum is displayed in the Graph Window. 

3. Select At maximum or Abscissa. 
At maximum uses the abscissa position of the highest peak.  
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4. If you select Abscissa, enter the required value.  

OR 

You may use the vertical cursor to determine the exact value.  Place the 
mouse in the Abscissa field. Select Vertical Cursor Cont from the View 
menu. Use the mouse to position the vertical cursor at the required location.  
The value in the field updates to the position of the vertical cursor.  Click 
the mouse outside the field to accept the value. 

5. If you select Abscissa, enter the required Ordinate Value. 

NOTE:  All Normalize calculations are performed in absorbance. The Ordinate Value is 
in absorbance. 

6. Click Calculate. 
The resultant spectrum is displayed in the Result Window. 

7. To save the resultant spectrum, ensure that the Result Window is selected 
and choose Save As from the File menu. 
The Spectra Save As dialog is displayed. The default filename of the result 
spectrum is norm**.yy, where ** is an autoincremented number and yy is 
the same file extension as the spectrum displayed in the Graph Window. 
The results are saved to the ../data directory.  

NOTE:  You may alter the automatic file name. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 

 
 

 
 
 

 
 
 



Arithmetic Application 

117 

Reflection Correction 

Use the Reflection Correction command to correct a reflectance spectrum for 
dark and white values. 

  

1. Click on the drop-down Select Dataset list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

2. Select the required spectrum. 
The spectrum is displayed in the Graph Window and the name of the 
spectrum is displayed in the Select Dataset field. 

NOTE:  If spectra have previously been selected, these are listed in the drop-down list 
and may be selected. 

3. Click on the drop-down R100 list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

4. Select the required spectrum. 
The file extension of the R100 spectrum is .r1. The spectrum is displayed in 
the Graph Window and the name of the spectrum is displayed in the R100 
field. 
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NOTE:  The R100 spectrum (white reference material) must cover the spectral range of 
the spectrum to be corrected. 

5. Click on the drop-down R0 list and select <disk>. 
An Open spectrum from disk, file selector is displayed. 

6. Select the required spectrum. 
The file extension of the R0 spectrum is .r0. The spectrum is displayed in 
the Graph Window and the name of the spectrum is displayed in the R0 
field. 

NOTE:  The R0 spectrum (spectral curve of a dark measurement) must cover the spectral 
range of the spectrum to be corrected. 

7. Click Calculate. 
The resultant spectrum is displayed in the Result Window. 

8. To save the resultant spectrum, ensure that the Result Window is selected 
and choose Save As from the File menu. 
The Spectra Save As dialog is displayed. The default filename of the result 
spectrum is reflc**.yy, where ** is an autoincremented number and yy is 
the same file extension as the spectrum displayed in the Graph Window. 
The results are saved to the ../data directory.  

NOTE:  You may alter the automatic file name. Any text entered in the Infoline field is 
saved with the spectrum and is displayed in the information line when the 
spectrum is displayed. 

 

The correction is automatically 
performed using the following 
formula: 
 

 
Ractual = Rmeasured – (R0)  (R100) 
                       100 – (R0) 
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Selection 

Use the Selection command to determine ordinate values at defined abscissa 
values. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum that you wish to perform the calculations on. 
The spectrum is displayed in the Graph Window. 
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3. Enter the Wavelength at which you wish to calculate the Ordinate value.  

OR 

You may use the vertical cursor to determine the exact value.  Place the 
mouse in the Wavelength field.  Select Vertical Cursor Cont from the 
View menu. Use the mouse to position the vertical cursor at the required 
location.  The value in the field updates to the position of the vertical 
cursor.  Click the mouse outside the field to accept the value. 

4. If required, enter the Data Interval of the spectrum. 
If the Data Interval is entered, the Wavelength value is automatically 
updated each time Select Abscissa Value is clicked, enabling a series of 
incremented wavelengths to be added to the table. If the Data Interval is not 
entered, only the current value in the Wavelength field is added. 

5. Click Select Abscissa Value 
The value in the Wavelength field is added to the table in the Result 
Window. 

6. Click Read Ordinate Value. 
The Ordinate value for the selected wavelength is added to the table, 
together with the spectrum name and any information saved with the 
spectrum. 

7. If the Data Interval was entered, repeat steps 5 and 6 until all the required 
values have been entered in the table. 

NOTE:  If the Data Interval was entered, it is possible to enter all the abscissa values 
first . Repeatedly click Select Abscissa Value until all the required abscissa 
values have been entered in the table, then click Read Ordinate Value. All the 
ordinate values are then added to the table. 

8. If you wish to save the data, click Save As from the File menu. 
A Save As dialog is displayed. 
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Remove Abscissa 

Removes all the abscissa values and any associated ordinate values from the 
table. The spectrum name and information are retained. 

 

Remove Spectra 

Removes the spectrum name, information and any ordinate values from the 
table. The abscissa values entered are retained. 
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Slope 

Use the Slope command to calculate the slope and standard deviation of a 
spectral curve within a selected abscissa range. It can also be used to calculate 
Enzyme activity and Substrate. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectrum is displayed in the Graph Window. 
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3. Enter the Slope from and to values. 

OR 

You may use the vertical cursor to determine the exact value.  Place the 
mouse in the required field.  Select Vertical Cursor Cont from the View 
menu. Use the mouse to position the vertical cursor at the required location. 
The value in the field updates to the position of the vertical cursor. Click 
the mouse outside the field to accept the value. 

4. Choose the Function. 

5. If Enzyme activity or Substrate is selected, enter the required Factor. 

NOTE:  No factor is required when calculating the slope. A factor, other than 1, is 
needed when calculating Enzyme activity or Substrate. When calculating 
Enzyme activity, the factor must correspond to the unit absorbance per minute. 

The enzyme activity is calculated using the following equation: 

Enzyme activity = slope * factor * 60 

6. Click Calculate. 
The results are displayed in the Result Window. 
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Smooth 

Use the Smooth command to smooth spectral data. 

 

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 
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3. Select the Smooth Type from the drop-down list. 

Cubic Golay-Savitzky: Golay-Savitzky smoothing, using a cubic polynomial. 

Moving Average: Smoothing, using the statistical mean of the selected number 
of data points. 

Quadratic Golay-S:  Golay-Savitzky smoothing, using a quadratic polynomial. 

Triangular: Smoothing, using a weighted moving average. 
 

 

4. Select the Number of Points. 
The Number of Points defines the degree of smoothing applied to the 
spectrum; the more points, the more smoothing that is applied. 

5. Click Calculate. 
The smooth calculation is performed and the resultant spectrum/spectra  are 
displayed in the Result Window. 

6. To save the resultant spectra, ensure that the Result Window is selected and 
choose Save As from the File menu. 
The Spectra Save As dialog is displayed, enabling you to save the 
smoothed spectrum. The default filename of the smoothed spectrum is 
smooth**.yy, where ** is an autoincremented number and yy is the same 
file extension as the spectrum displayed in the Graph Window.  The results 
are saved to the ../data directory. The ordinate unit of the resulting curves 
depends on the ordinate unit of the source data in the Graph Window. 

NOTE:  You may alter the automatic file names. The InfoLine contains the path and 
filename of the spectrum that was smoothed.  Any text entered in the Infoline 
field is saved with the spectrum and is displayed in the information line when the 
spectrum is displayed.  
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Film Thickness 

Use the Film Thickness command to calculate the film thickness of single 
layers. 

  

1. From the File menu select Open, or click . 
If no spectra have previously been selected since opening the module, an 
Open Spectra from disk file selector is displayed. 
If at least one other spectrum has previously been opened, an Add Spectra 
from dialog is displayed listing the previously opened spectra. Click on the 
name of the required spectrum in the list or, if the spectrum is not listed, 
click Add spectra from disk, to display a file selector. 

2. Select the required spectrum or spectra that you wish to perform the 
calculations on. 
The spectra are displayed in the Graph Window. 
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3. Enter the Start and End values for the Thickness Wavelength Fringes. 

OR 

You may use the vertical cursor to determine the exact values.  Place the 
mouse in the field whose value you want to determine e.g. Start.  Select 
Vertical Cursor Cont from the View menu. Use the mouse to position the 
vertical cursor at the required location. The value in the field updates to the 
position of the vertical cursor. Click the mouse outside the field to accept 
the value. 

4. Enter the number of Fringes in the specified wavelength range. 

OR 

Select Automatic. 
The software automatically searches for fringes in the specified wavelength 
range. 

5. Enter the Refractive Index value of the material. 

6. Enter the Angle of incidence. 
This is the angle of light incident on the sample. 

7. Select Angströms or Micrometers. 
The film thickness will be calculated using the chosen units. 

8. Click Calculate. 
The film thickness is calculated and the results displayed in the Result 
Window. 
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The calculation is performed using the 
following formula: 
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d = Thickness 
N = Fringes (max. between the 
specified wavelength) 
λ1 = Wavelength start 
λ2 = Wavelength end 
n = Refractive index 
α = Angle of incidence 
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Result Template 

Numerical results, for example, a Slope calculation, are presented and stored in 
tabular form. The format and contents of each table is governed by a results 
template. 

A results template is a text file consisting solely of standard ASCII characters.  It 
holds a frame of texts - e.g., titles, comments, headings, etc. - together with 
special keywords, characterized by a leading $ sign. The keywords serve as 
tokens for values that are read from the system - e.g., date, time, instrument 
parameters, ordinate and abscissa readings, etc. 

Default results templates are included with the software.  If required, you can 
generate your own results templates for customized reports. A text editor such as 
Notepad, that generates ASCII files, can be used to generate a results template.  
Every line in the results template can contain up to 200 characters. The PC 
screen display actual is limited to 80 characters. Take care when generating a 
result template that any text you wish to have on the screen is actually visible. 

Naming and Saving a Results Template 

A results template should be saved in the directory ..\uvwinlab. It must have the 
extension .txt, and the name should reflect the type of calculation. For example, 
the default template for the area calculation has the filename dh_area.txt. 

Example Results Template 

Good examples of customized results templates are the default templates 
(dh_area.txt, dh_aritv.txt, dh_avsv.txt, dh_hh.txt, dh_enzac.txt, dh_slope.txt, 
dh_subs.txt, or dh_film.txt). These results templates governs the format of the 
output for the numeric values of the Advanced Spectroscopy Software module 
Arithmetic. 
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e.g. Area Template 
 

$HEADER 
 

Analyst:  $ANALYST  
Date:     $DATE    Time:   $TIME 

 
Name           Range               Baseline 
Data Set       from      to        from      to        Total Area    Area to Base  
-------------------------------------------------------------------------------------------------------------------------------------- 
$SI $AREAC01[04.02] $AREAC02[04.02] $AREAB01[04.02] $AREAB02[04.02] $AREAT  $AREAA 
$REPEAT 

  

Selecting the calculations to be listed in the Arithmetic menu and 
changing the default templates for calculations 

1. From the Utilities menu select Option. 
The Option dialog is displayed. 

2. Click Selected Calculation. 
The Selected Calculation dialog is displayed. 

3. Select the required calculations On. 
Any calcuations that are switched Off will not appear in the Arithmetic 
menu. 
The follwing calculations have a result template defined when selected On: 
area, arithmetic value, average value, calculate height, slope, film 
thickness.  

4. To change a result template, double-click on the template name. 
A file selector is displayed. 

5. Select the required template. 

6. Click OK. 
The file selector closes and the calculation result template is updated. 
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Template Keywords 

The keywords are placeholders for the current value of a variable, for example, 
$DATE represents the current date. 

 

 Keyword 

General  

Header information $HEADER 

Analyst name  $ANALYST 

PC Date $DATE 

PC Time $TIME 

Spectrum name $SI 

Spectrum information $SC 

Format of numerical values e.g. $AREAT[02.02] 
The total area value is output with two digits before 
and two digits after the decimal sign. 

[XX.XX] 

If a line in a results template should be used from 
sample to sample, it must end with the keyword 
$REPEAT. 

If $REPEAT is not present, the screen display is 
presented and cleared after each sample. 

$REPEAT 

 

  

Area  

Abscissa range start for the area calculation $AREAC01 

Abscissa range end for the area calculation $AREAC02 

Baseline abscissa range start for the area calculation $AREAB01 
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Baseline abscissa range end for the area calculation $AREAB02 

Total area $AREAT 

Area to base $AREAA 

  

Arithmetic Value  

Ordinate value first wavelength read out $ARIV01 

First wavelength $ARIW01 

Ordinate value second wavelength read out $ARIV02 

Second wavelength $ARIW02 

Ordinate value third wavelength read out $ARIV03 

Third wavelength $ARIW03 

First factor $ARIF01 

Second factor $ARIF02 

Arithmetic result $ARIR 

  

 

Average, Standard Deviation, Root Mean Square  

 

Abscissa range start for the calculation $AVR01 

Abscissa range end for the calculation $AVR02 

Average value $AVA01 

Standard deviation value $AVS01 
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Root mean square value $AVRMS01 

  

Calculate Height  

Peak wavelength $CHHP01 

Abscissa range start for the calculation $CHHR01 

Abscissa range end for the calculation $CHHR02 

Total height $CHHT01 

Height to base $CHHB01 

  

Slope  

Abscissa range start for the calculation $SLOPER01 

Abscissa range end for the calculation $SLOPER02 

Slope $SLOPES01 

Intercept $SLOPEI01 

Standard Deviation $SLOPESTD01 

Factor $SLOPEF01 

dA/min $SLOPEDA01 

Enzyme Activity EA $SLOPEEA01 

Delta A $SLOPEAD01 

Substrate $SLOPEUS01 
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Film Thickness  

Abscissa range start for the calculation $FILMR01 

Abscissa range end for the calculation $FILMR02 

Fringes $FILMF01 

Refractive Index $FILMRI01 

Angle of Incidence $FILMA01 

Film Thickness $FILMT01 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Single Read application enables measurements (intensity, concentration, 
polarization, anisotropy) to be made at fixed wavelengths. The data are saved on 
the hard disk in an Excel compatible file format. 

NOTE:  Polarization and anisotropy cannot be measured with the LS 45. 
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Using the Application 

1. Select Read from the Application menu. 
The Read application is opened. 

 

2. Select the required reading. 
The options available will depend on the accessories fitted to your 
instrument. 

3. Enter the required Setup parameters. 
The parameters available will depend on which type of reading you 
selected.  The parameters are discussed below. 

4. Click on the green traffic light (Start / Stop button) in the toolbar to start 
the method. 
The intensity/value then scrolls (is automatically repeated) until you click 
on the red traffic light. 

5. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Setup Parameters tab 

Intensity Parameters 
 

Parameter Description 

Intensity / 
Concentration 

The intensity or concentration is displayed here. The 
concentration is displayed if the Apply AutoConc. factor 
option is selected. 

Subtract BG Use the background (BG) subtraction option to automatically 
subtract the given background from the signal. The 
background intensity is stored in the results file.  Enter the 
required intensity or click Measure BG to measure the 
background intensity. The instrument is setup with the method 
parameters (wavelengths, slit widths) before the measurement 
is done.  

NOTE:  Four different background intensities are used if the 
cell changer accessory is fitted. To (re)measure the 
background for a cuvette first click on the desired cuvette 
position in the cell changer accessory box and then click 
Measure BG. 
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Parameter Description 

Apply 
AutoConc 
Factor 

Select this option if you want to display the signal in terms of 
concentration instead of intensity, assuming the signal 
intensity is directly proportional to concentration.  The 
concentration is calculated as Conc = ACFactor x (Intensity - 
Background).  The factor is stored in the results file. 

Enter the required factor or to determine the factor 
automatically, place a cuvette containing a sample of known 
concentration (reference sample) in the sample compartment, 
enter the concentration value (Conc) and the concentration 
unit (Unit) and then click Measure AC. The factor is 
determined using the given wavelengths, slitwidths and 
integration time and calculated as  
ACFactor = Conc / (Intensity - Background).  

NOTE:  Only one factor is available, even if the 4 cell 
changer accessory is fitted. 

Polarization Parameters  
 

Parameter Description 

Polarization The polarization or value is displayed here. The polarization is 
measured using the following equation: 

( )
( )vhvv

vhvv

IGFI
IGFI

onPolarisati
⋅+
⋅−

=  

where Ivv is the intensity with the polarizers vertical and 
vertical (excitation and emission), Ivh is the intensity with the 
polarizers vertical and horizontal (excitation and emission) and 
GF is the Grating Factor. 
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Parameter Description 

GF The Grating Factor GF corrects for instrumental polarization. 
It can be entered manually or to calculate it automatically, 
insert a depolarizing sample into the cuvette holder and click 
Calc. GF to calculate the grating factor. The grating factor is 
calculated using the following equation: 

hh

hv

I
I

GF =  

where Ihv is the intensity with the polarizers horizontal and 
vertical (excitation and emission), and Ihh is the intensity with 
the polarizers horizontal and horizontal (excitation and 
emission). 

Anisotropy Parameters 
 

Parameter Description 

Anisotropy The anisotropy value is displayed here. The anisotropy is 
measured using the following equation: 

( )
( )vhvv

vhvv

IGF2I
IGFI

Anisotropy
⋅⋅+

⋅−
=  

where Ivv is the intensity with the polarizers vertical and 
vertical (excitation and emission), Ivh is the intensity with the 
polarizers vertical and horizontal (excitation and emission) and 
GF is the Grating Factor. 
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Parameter Description 

GF The Grating Factor GF corrects for instrumental polarization. 
It can be entered manually or to calculate it automatically, 
insert a depolarizing sample into the cuvette holder and click 
Calc. GF to calculate the grating factor. The grating factor is 
calculated using the following equation: 

hh

hv

I
I

GF =  

where Ihv is the intensity with the polarizers horizontal and 
vertical (excitation and emission), and Ihh is the intensity with 
the polarizers horizontal and horizontal (excitation and 
emission). 

Biokinetics Accessory Parameters  
 

Parameter Description 

Temperature Here the temperature from the biokinetics accessory is 
displayed. The displayed sample temperature TSample is 
(depending on the status of the Calibrate temperature option) 
either the uncorrected block temperature Tblock or the 
corrected block temperature, calculated from the block 
temperature Tblock using the calculated temperature 
calibration factor and the ambient temperature Tamb: 

( ) BlockAmbBloclSample TTTfactorT +−= *  

NOTE:  The Calibrate temperature option is only available 
if a temperature calibration factor was determined and a value 
is entered for Ambient Temperature. A calibration factor is 
determined using the Instrument Setup Application (see 
Biokinetics Accessory Parameters starting on page 55). 



Single Read Application 

143 

Other Accessories 

• If a Stirrer is fitted, you can select one of the three stirrer speeds. Select the 
low stirrer speed for cell suspensions and biochemical reactions and high 
stirrer speed for very rapid mixing. 

• If a Cell Changer is fitted, to select a cuvette position, click on the 
corresponding radio button (only visible if the 4 cellchanger accessory is 
fitted). 

Excitation / Emission Parameters 
 

Parameter Description 

Excitation 
wavelength 

Enter the excitation wavelength in nm. 

Emission 
wavelength 

Enter the emission wavelength in nm. 

Excitation slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or 5 nm. 
The best signal-to-noise ratio is obtained by selecting a large 
slit width. 

Emission slit The emission slit width is the spectral bandwidth of the 
emission monochromator.  In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or 5 nm. 
The best signal-to-noise ratio is obtained by selecting a large 
slit width. 

Integration 
time 

Enter the required integration time in seconds or minutes 
depending on the time unit selected.  The optimal signal-to-
noise ratio is obtained by selecting a long integration time. 
However for fast kinetics a short integration time should be 
used. Typical values range from 0.1 to 1.0 seconds. 
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Save Parameters 
 

Parameter Description 

Save Select one of the following options to determine how the data 
are saved (the data are saved in an Excel compatible format 
using tabs as delimiter): 

continuously - Every time a new result is measured it is saved 
to the results file with its collection time. Use this option to 
measure intensity changes against time. The data interval is 
determined by the integration time. However, the timing is less 
accurate than in the TimeDrive application. 

on stop - The current result is saved to the results file with the 
collection time when data collection is stopped. This enables 
you to wait for the intensity to equilibrate, for example when 
the measurement is based on a reaction or chelation. 

don’t save - The data are not saved. Use this option if you for 
example want to use the read application to optimize the 
instrument setup for other applications. 

Destination 
filename 

Enter the filename for saving the data or double-click in the 
textbox and a file selector will appear to enable you to 
overwrite a file.  The result files are always stored in the 
default FL WinLab data directory. 

 



Single Read Application 

145 

User Info tab 

On this tab, information about the sample and analyst are entered. 

 
 

Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

Sample info This information will be stored in the dataset header. The first 
line of the information is stored in the ‘Comment’ field of the 
header, which is displayed in all graph windows. The complete 
information is stored in the ‘FL memo’ field of the dataset, and 
can be viewed using Report Builder. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 
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Parameter Description 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Scan application is used for collecting various types of spectral data in a 
variety of modes (fluorescence, phosphorescence and bioluminescence). 

There are four scan modes, selected by clicking on the icons: 

 

Single scan mode 

There are five types of scan available from the Single scan mode: 

• An excitation spectrum recorded using a fixed emission wavelength. The 
start and final wavelengths refer to the excitation monochromator.  

• An emission spectrum recorded using a fixed excitation wavelength. The 
start and final wavelengths refer to the emission monochromator.  

• A synchronous scan, where both monochromators are scanned 
simultaneously with a constant wavelength difference between the excitation 
and emission monochromators. This technique is used for rapid screening in 
environmental analysis, for example for differentiating between various 
types of crude oil (oil fingerprinting), since the technique greatly simplifies 
the spectra of complex mixtures with overlapping spectral components. 
In a synchronous scan, the start and final wavelengths always refer to the 
excitation monochromator and the emission monochromator always starts at 
a higher wavelength than the excitation monochromator. 
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• A synchronous scan, where both monochromators are scanned 
simultaneously with a constant energy difference between excitation and 
emission monochromators. The emission monochromator accelerates 
relative to the excitation monochromator.  In a synchronous energy scan, a 
synchronous spectrum is recorded at a constant energy difference 
(wavenumber) between excitation and emission monochromator.  This 
technique can be used for the investigation of very complex mixtures where 
the spectral sensitivity at constant wavelength difference is too low. 
Scanning at constant energy difference between the monochromators has an 
advantage over the recording of spectra at constant wavelength difference by 
having a higher spectral resolution and lower background fluorescence. 

• A pre-scan using either one or both monochromators can be used to 
determine the optimum excitation and emission wavelength for unknown 
samples. 

3-D scan mode 

In 3-D scan mode, four scan types - excitation scan, emission scan, synchronous 
scan at constant wavelength and synchronous scan at constant energy difference 
are available.  In each case, a scan is repeated automatically over the range 
parameters entered, however between each scan the fixed parameter is 
incremented. For an emission 3D scan, an emission scan is repeated, but each 
time the excitation wavelength is incremented. This results in the collection of 
excitation and emission data in a single graphic. 

When a 3D Scan method is run, data is automatically saved as a 3D dataset with 
the same name as the first file in the run, with the extension SP3. The 3D 
graphics can be viewed and edited with the 3D View application. 

Kinetic scan mode 

In the Kinetic scan mode, four scan types - excitation scan, emission scan, 
synchronous scan at constant wavelength and synchronous scan at constant 
energy difference, are available.  Spectra are collected with respect to time; after 
an external contact closure; or after a keyboard entry. 

When a Kinetic method is run, the data is automatically saved as a 3D dataset 
with the same name as the first file in the run, with the extension SP3. The 3D 
graphics can be viewed and edited with the 3D View application. 
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Accumulation scan mode 

In Accumulation scan mode, four scan types - excitation scan, emission scan, 
synchronous scan at constant wavelength and synchronous scan at constant 
energy, are available. After all the spectra have been scanned they are averaged 
in order to eliminate any random noise and therefore increase the signal-to-noise 
ratio.  The parameters for the individual scans are identical to the parameters for 
the scan types in single scan mode. 

Subsequent to clicking on the green traffic light, the individual spectra will be 
scanned and superimposed in real time. Once the selected number of 
accumulation scans has been carried out, all the spectra will be averaged onto a 
single spectrum and displayed.  The individual raw spectra, that is the spectra 
from which the average spectrum was determined, will not be saved. 
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Performing a Pre-Scan 

Background 

There are three ways of recording a pre-scan: 

An Excitation monochromator pre-scan (with the emission 
monochromator at constant wavelength). 

Select the start and end wavelengths for the excitation monochromator by 
clicking on the excitation from and to boxes and entering the wavelengths. The 
starting wavelength must be smaller than the final wavelength. The emission 
monochromator from and to boxes should be set to the same wavelength. 

The excitation slit width should be set between 2.5 nm and 5 nm and the 
emission slit width set between 10 nm and 15 nm. In order to obtain the optimal 
signal-to-noise ratio enter a slow scan speed such as 150 nm/min. For 
photochemically sensitive samples select a high scan speed.  

At the end of the pre-scan the maximum intensity (*) and the corresponding 
excitation wavelength is displayed. Following the pre-scan, the excitation 
monochromator will be set to the wavelength of maximum intensity and the 
value inserted in the excitation box. 

An Emission monochromator pre-scan (with the excitation 
monochromator at constant wavelength). 

Select the start and end wavelengths for the emission monochromator by 
clicking on the emission from and to boxes and entering the wavelengths. The 
starting wavelength must be smaller than the final wavelength. The excitation 
monochromator from and to boxes should be set to the same wavelength. 
Typically this should correspond to the wavelength of maximum absorption, if 
known. 

The excitation slit width should be set between 10 nm and 15 nm and the 
emission slit width between 2.5 nm and 5 nm. In order to obtain the optimal 
signal-to-noise ratio enter a slow scan speed. For photochemically sensitive 
samples select a high scan speed. 

At the end of the pre-scan the maximum intensity (*) and the corresponding 
emission wavelength is displayed. 
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Following the pre-scan, the emission monochromator will be set to the 
wavelength of maximum intensity and the value is inserted in the emission box. 

A combined Excitation/emission pre-scan (automatic sequence of 
the above pre-scans). 

Select the start and end wavelengths for the excitation monochromator by 
clicking on the excitation from and to boxes and entering the wavelengths. The 
starting wavelength must be smaller than the final wavelength. The range should 
cover the wavelength of maximum absorption, if known. Select the start and end 
wavelengths for the emission monochromator by clicking on the emission from 
and to boxes and entering the wavelengths. The starting wavelength must be 
smaller than the final wavelength. 

Both the excitation and emission slit width should be set between 2.5 nm and 5 
nm. In order to obtain the optimal signal-to-noise ratio enter a slow scan speed. 
For photochemically sensitive samples select a high scan speed. 

 To perform a pre-scan over the entire wavelength range of the excitation 
and emission monochromators, click Full range.  
The minimum and maximum wavelengths for the excitation and emission 
monochromator will then be automatically inserted in the corresponding 
boxes.  

Functional description 

On starting the pre-scan, the excitation and emission scans will automatically be 
performed in the following manner: 

Excitation Pre-Scan 

• The emission monochromator will be set to 'zero order' and an excitation 
spectrum will be recorded over the entire wavelength range. 

• On completion of the excitation scan, the excitation monochromator will be 
set to the wavelength that was found to produce maximum intensity. 
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Emission Pre-Scan 

• The excitation monochromator will be set to a fixed wavelength (either user-
input or that obtained from the excitation Pre-Scan) and an emission 
spectrum will be recorded over the entire wavelength range. 

• On completion of the emission scan, the emission monochromator will be 
set to the wavelength that was found to produce maximum intensity. 

Following the pre-scan, the excitation and emission monochromators will be set 
to the wavelengths producing maximum intensity and the values are entered in 
the excitation and emission boxes. However, the Pre-Scan function is not 
intended to supply photophysically exact data: it should be used only as a 
starting point for unknown samples. If the intensity exceeds 999.999 (the 
maximum signal for the instrument), then no sensible peak information can be 
derived from the data. If the sample is highly light-scattering, then harmonic 
order peaks can obscure the fluorescence peaks. In addition it is also possible to 
automatically mark the Rayleigh and Raman scatter bands together with any 
second order peaks. 

NOTE:  The pre-scan button appears only in the Single scan mode. 
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Using the Application 

1. Select Scan from the Application menu. 
The Scan dialog is displayed.  

 

2. Select the required scan mode (single, 3D, kinetic, or accumulation) from 
the large toolbar icons next to the traffic lights icon. 

3. Select the scan type (Excitation, Emission, Synchronous or Pre-scan) 
by clicking the relevant button. 

4. Enter the required parameters on each tab of the software. Use the tabs to 
move between pages. 

5. Click on the green traffic light to start the application. 

6. Use the icons in the toolbar to format the graphic display, as discussed in 
Application Toolbars on page 74.  

7. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Setup parameters tab 

The appearance of the Setup parameters page depends on the scan mode and 
type. 

Single Scan Range Parameters 

 
 

Parameter Description 

Start Scan start wavelength. This must be smaller than the end 
wavelength. 

End Scan end wavelength. This must be greater than the start 
wavelength. 

Excitation or 
Emission 

Fixed monochromator´s wavelength in nm. For excitation 
scans this is the position of the emission monochromator, and 
should be at a wavelength greater than the end of the 
excitation scan. For emission scans this is the position of the 
excitation monochromator, which should be at a wavelength 
shorter than the start of the emission scan. 
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Parameter Description 

Ex slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best 
resolution for excitation spectra with narrow bands, select a 
narrow slit width, for example 2.5 or 5 nm. To record 
excitation spectra with broad bands, you may select a wide 
excitation slit width. The best signal-to-noise ratio is obtained 
by selecting a large slit width. 

Em slit The emission slit width is the spectral bandwidth of the 
emission monochromator. For good resolution of spectra with 
narrow bands, select a narrow width for the emission slit. To 
record emission spectra with broad bands, select a large 
emission slit width. The best signal-to-noise ratio is obtained 
by selecting a large slit width. 

Scan speed Since the data interval for scans is always 0.5 nm, the scan 
speed determines the integration time of data acquisition. For 
example a scan speed of 300 nm/min (5 nm/sec) is equivalent 
to an integration time of 0.1 sec. (Integration time = data 
interval / scan speed).  The optimal signal-to-noise ratio is 
obtained by selecting a slow scanning speed.  However, for 
photochemically sensitive samples a fast scan speed should be 
used. 

Delta lambda Only available for Synchronous δλ scans. The wavelength 
difference between the monochromators is typically set 
between 10 nm and 100 nm, which should correspond to the 
Stoke shift between the excitation and emission maxima of the 
compound of interest. Much sharper bands are obtained 
compared to excitation or emission spectra. The synchronous 
spectrum of a complex mixture shows simpler spectral 
structure and thus achieves a higher degree of sensitivity and 
selectivity. 
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Parameter Description 

Delta energy Only available for Synchronous δE scans.  Here the energy 
difference between both monochromators is entered and are 
typically within the range -1000 to -4000 cm-1 (the energy 
difference has a negative sign as the emission monochromator 
always starts at a higher wavelength than the excitation 
monochromator.  Synchronous energy scans provide better 
selectivity across the spectral range, particularly for complex 
mixtures. 

Pre-Scan Parameters 

 
 

Parameter Description 

Full Range Clicking Full Range sets the Excitation Range and Emission 
Range to the maximum ranges of both monochromators. 

Excitation 
Range 

Select start and end wavelengths for the excitation 
monochromator. The starting wavelength must be smaller than 
the end wavelength. Set the From and To boxes to be the same 
to perform an emission pre-scan only. 

Emission 
Range 

Select the start and end wavelengths for the emission 
monochromator. Starting wavelength must be smaller than the 
end wavelength. Set the From and To boxes to the same 
wavelength to perform an excitation pre-scan only. 
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Parameter Description 

Ex slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best 
resolution for spectra with narrow bands, select a narrow slit 
width, for example 2.5 or 5 nm. To record spectra with broad 
bands, select a wide excitation slit width. The best signal-to-
noise ratio is obtained by selecting a large slit width. 

Em slit The emission slit width is the spectral bandwidth of the 
emission monochromator. For a good resolution of spectra 
with narrow bands, select a narrow width for the emission slit. 
To record spectra with broad bands, select a large emission slit 
width. The best signal-to-noise ratio is obtained by selecting a 
large slit width. 

Scan speed Since the data interval for scans is always 0.5 nm, the scan 
speed determines the integration time of the data acquisition. 
For example a scan speed of 300 nm/min (5 nm/sec) is 
equivalent to an integration time of 0.1 sec. (Integration time = 
data interval / scan speed).  The optimal signal-to-noise ratio is 
obtained by selecting a slow scanning speed. However for 
photochemically sensitive samples a fast scan speed should be 
used. 

Auto Peak 
Find 

To exclude Rayleigh, Raman and second order scatter peaks 
from the Automatic Peak Find. A series of check buttons 
appear in the toolbar during the PreScan data collection, and 
clicking on one of these superimposes a green area on the scan 
graphic indicating the expected region for that scatter peak. If 
a peak is seen inside the green area, then the user can be 
suspicious of its validity. 

Solvent Lists the most frequently used solvents - Water, Ethanol, 
Cyclohexane, Chloroform, and Carbon tetrachloride. The 
wavenumber difference between excitation wavelength and the 
Raman band will automatically be entered as the Raman 
Wavenumber.  
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Parameter Description 

Raman 
Wavenumber 

To enter the Raman wavenumber for a solvent not in the 
Solvent list, select Other as the Solvent and enter the Raman 
energy for the solvent to be used, taking into account that the 
Raman energy has a negative sign as Raman scatter is of 
longer wavelength and thus possesses less energy than the 
excitation radiation. 

Rayleigh 
scatter check 

Light scattered by the sample at the excitation wavelength is 
called Rayleigh scatter. Selecting the option will exclude the 
area where this scatter is expected from the peak find:    

2
hEmSlitWidthExSlitWidtWl +

=∆   

excluded area = WlExWl ∆−  to WlExWl ∆+    

The excluded area can be displayed graphically by using the 
Display Rayleigh peak area button on the View Results page: 
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Parameter Description 

Raman 
scatter check 

Photons can be scattered by the solvent, resulting in an 
emission at a predictable longer wavelength than the 
excitation.  This is Raman scatter. The position of the Raman 
scatter peak depends on solvent-solvent interactions (hydrogen 
bonding, Van Der Waal`s interactions).  Select the Raman 
Wavenumber as discussed above, the area where the Raman 
peak of the selected solvent is expected will now be excluded 
from the automatic peak find: 

RamanWNR
ExWl

RamanWNr
ExWl

RamanWl
1

1

⋅

−
=   

2
hEmSlitWidthExSlitWidtWl +

=∆   

excluded area = WlRamanWl ∆−  to WlRamanWl ∆+  

The excluded area can be displayed graphically by using the 
Display Raman peak area button on the View Results page: 
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Parameter Description 

2nd order 
check 

When the emission monochromator is scanned through a 
wavelength equal to 2 or 3 times the excitation wavelength, 
symmetrical peaks are observed, due to excitation light being 
transmitted to the detector. These peaks are second order and 
third order scatter respectively and are caused by 
characteristics of all gratings, which transmit the fundamental, 
selected wavelength but additionally harmonics of this 
wavelength. 

Selecting 2nd order check will automatically exclude any 
second order peaks in the emission spectrum from the 
automatic peak find. The excluded area can be displayed 
graphically by using the two Display second order peak area 
buttons on the View Results page: 

 

3D Scan Range Parameters 

 
 

Parameter Description 

Number of 
scans 

The number of required scans must be greater than 1. 
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Parameter Description 

increment  Enter the increments per scan. A typical parameter set for a 3D 
scan would be: Emission scan type, range 400-650 nm. Excitation 
wavelength 250 nm, increment 5 nm, number of scans 30. Slits  
5/5 nm (Ex/Em). This set would produce 30 emission scans over 
the range 400-650 nm, covering the excitation range 250-400 nm. 

Kinetic Scan Range Parameters 

 
 

Parameter Description 

Number of 
scans 

The number of scans must be greater than 1. 

Delay Enter the delay time between successive kinetic scan cycles. 

Repeat with 
time 

Select this option if you wish to start each kinetic scan after a 
defined delay, including the first cycle. 

Repeat on 
User 
Prompt 

Select this option if you wish to start each kinetic scan manually, 
so that the sample can be removed/replaced between scans. A 
dialog box will appear before each scan, click OK or press 
ENTER on the keyboard to start the next cycle. 

Repeat on 
External 
Contact 

Select this option if you wish to start each kinetic scan from the 
external remote contact closure, to allow automation when 
coupled to an external device, for example an autosampler. 

Repeat on 
Sipper 
Contact 

Select this option to start each kinetic cycle from the external 
event contact closure, or the sipper button. 
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Parameter Description 

Auto lamp 
off 

Select this option to automatically switch off the source lamp 
between measurements.  This is useful to preserve the source 
lifetime and to avoid photobleaching. 

Delay 
before 
meas. 

Enter the delay between turning the source on and starting 
measurement (the instrument needs no delay, the source 
stabilizes instantly) to allow for sample stabilization.  If used 
together with the kinetic cycle delay, both delays are added 
together. 

Accumulation Scan Parameters 

 
 

Parameter Description 

Number of 
Accumulation scans 

The number of accumulated scans must be greater 
than 1. 

Datafile Saving Parameters 
 

Parameter Description 

Result 
Filename 

Enter the name of the file for saving the data or double-click in the 
textbox and a file selector will be displayed to enable you to 
overwrite a previous file. 

NOTE:  Result files are always stored in the default FL WinLab 
data directory. 
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Parameter Description 

Auto 
increment 
filenames 

If this option is selected the application generates a new numbered 
filename for each run. The base filename is given as the Result 
Filename, and is extended with a number starting from #001. If a 
file with this filename already exists on the hard disk in the current 
FL WinLab data directory, the number is incremented by one, until 
the filename is unique. The numbering process can be forced to 
start from a different number by adding a number to the base 
filename, for example Test#5.sp would make the first generated 
filename Test#005.sp and the second Test#006.sp and so on. 

Realtime options tab 

 
 

Parameter Description 

Response 
width 

The response width must be at least three times the data interval 
(which is 0.5 nm). It cannot be larger than 99 times the data 
interval and it must be an uneven multiple of the data interval.  
Valid values for the width are therefore 1.5, 2.5, 3.5, up to 44.5. 
The program inserts the nearest valid response if an invalid value 
is entered, for example a response of 10 becomes 9.5.   Selecting 
Auto automatically sets the response width according to the 
scanning slit width 
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Parameter Description 

Auto 
Background 
Subtract 

Select this option to automatically subtract the chosen 
Background Spectrum from each spectrum in real-time. If the 
data type or wavelength range of the background spectrum is 
incompatible with the scan range, or the specified background 
spectrum cannot be found, an appropriate error message will 
appear on starting the scan.  The name of the background 
spectrum is stored in the header of the dataset in the FL memo 
field. 

When selecting the background spectrum, double-click on the 
Background Spectrum box to display a file selector.  

Ordinate 
label 

The label will be displayed on the ordinate axis of the graph and 
will be stored in the dataset. 

Ordinate 
Max  

Sets the default ordinate maximum value.  Leave empty to retain 
the same ordinate value as last time. 

Ordinate 
Min 

Sets the default ordinate minimum value.  Leave empty to retain 
the same ordinate value as last time. 

Auto-clear 
curves 

If this option is selected all curves are deleted from the graphic 
before a measurement starts, rather than each successive scan 
being superimposed on the previous scans. The curves are not 
deleted from the hard disk. 

User info tab 
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Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

Sample info This information will be stored in the dataset header. The first 
line of the information is stored in the ‘Comment’ field of the 
header, which is displayed in all graph windows. The complete 
information is stored in the ‘FL memo’ field of the dataset, and 
can be viewed using Report Builder. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 
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View results tab 

This page contains a toolbar in which graphics icons appear, depending on the 
selected scan mode.  For further details on viewing data in real-time see Generic 
Viewing Features starting on page 74. 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The TimeDrive application enables time-dependent luminescence measurements 
(fluorescence, phosphorescence and bioluminescence) to be made at fixed 
wavelengths, with defined intervals over a specified period of time. The data are 
recorded and saved on the hard disk in a file with the file extension .TD. 
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Using the Application 

1. Select TimeDrive from the Application menu. 
The TimeDrive application is opened. 

 

2. Enter the required parameters on each tab of the application.  
The parameters are discussed below. 

3. Click on the green traffic light in the toolbar to start the method. 
TheView Results tab is displayed automatically, use the icons in the toolbar 
to format the graphic display. 

4. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Setup Parameters tab 
 

Parameter Description 

Excitation 
wavelength 

Enter the excitation wavelength in nm. 

Emission 
wavelength 

Enter the emission wavelength in nm. 

Excitation slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or 5 nm. 
The best signal-to-noise ratio is obtained by selecting a large 
slit width. 

Emission slit The emission slit width is the spectral bandwidth of the 
emission monochromator.  In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or 5 nm. 
The best signal-to-noise ratio is obtained by selecting a large 
slit width. 

Duration Enter the total time for data collection for the TimeDrive in 
seconds or minutes, depending on the time unit selected. 

Data interval Enter the interval between two measuring points in seconds or 
minutes depending on the time unit selected. In TimeDrive 
mode the data interval is equivalent to the integration time. 

Single Read In single read mode the timing of the measurement is 
controlled by the PC rather than by the instrument. This has the 
drawback that the timing is less accurate, but it allows for more 
flexibility.  In single read mode the integration time can be 
different from the data interval, furthermore it is possible to 
monitor the temperature of the sample, if the biokinetics 
accessory is fitted.  The longest data interval is 1000 seconds 
(10 seconds in true TimeDrive mode).  The following * options 
only become available when Single Read is selected. 
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Parameter Description 

* Integration 
time 

Enter the required integration time in seconds or minutes, 
depending on the time unit selected. The optimal signal-to-
noise ratio is obtained by selecting a long integration time, 
however for fast kinetics a short integration time should be 
used. The integration time must be at least 1 second shorter 
than the data interval since the PC needs some time to receive 
and display the measured data and issue new commands. 

* Show 
temperature 

This option, only available if the Biokinetics Accessory is 
fitted, enables you to monitor the temperature of the sample 
during data collection. Once data collection starts, the data file 
with the extension .TD plus a second file using the same name 
but with the file extension .TDT (containing the uncorrected 
temperature of the block) will be displayed on the View results 
tab. 

* Auto lamp 
off 

If this option is selected the lamp is switched off automatically 
between measurements. This avoids photobleaching of the 
sample and preserves the source lifetime for long TimeDrives. 

* Delay 
before 
measurement 

This determines the delay between turning the source on and 
starting measurement (the instrument needs no delay, the 
source stabilizes instantly). This function allows for sample 
stabilization. 

* Background 
subtraction 

This automatically subtracts the background from the signal. 
The background intensity is stored in the header of the dataset 
in the FL memo field. 

Start options  The options of Remote Start, Keyboard Start, Immediate 
Start, and Show timed events are described in Start/stop 
options available when setting up application methods on page 
70. 
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Parameter Description 

Result 
Filename 

Enter the name of the file for saving the data or double-click in 
the textbox and a file selector will be displayed to enable you to 
overwrite a previous file. 

NOTE:  Result files are always stored in the default FL 
WinLab data directory. 

Auto 
increment 
filenames 

If this option is selected the application generates a new 
numbered filename for each run. The base filename is given as 
the Result Filename, and is extended with a number starting 
from #001. If a file with this filename already exists on the hard 
disk in the current FL WinLab data directory, the number is 
incremented by one, until the filename is unique. The 
numbering process can be forced to start from a different 
number by adding a number to the base filename, for example 
Test#5.sp would make the first generated filename 
Test#005.sp and the second Test#006.sp and so on. 

Realtime options tab 
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Parameter Description 

Response 
width 

The response width must be at least three times the data interval. 
It cannot be larger than 99 times the data interval and it must be 
an uneven multiple of the data interval, for example for a data 
interval of 1 sec valid values for the filter width are 3,5,7, up to 
99 sec. The program automatically calculates the next (smaller) 
valid response if an invalid value is entered, for the above 
example a response of 101 becomes 99, and 1 becomes 3. 

Background 
Subtract 

Select this option to automatically subtract the given Intensity 
from the signal.  The Intensity can either be entered manually or 
automatically by clicking Measure background.  

Ordinate 
label 

The label will be displayed on the ordinate axis of the graph and 
will be stored in the dataset. 

Ordinate 
Max  

Sets the default ordinate maximum value.  Leave empty to retain 
the same ordinate value as last time. 

Ordinate 
Min 

Sets the default ordinate minimum value.  Leave empty to retain 
the same ordinate value as last time. 

Auto-clear 
curves 

If this option is selected all curves are deleted from the graphic 
before a measurement starts, rather than each successive scan 
being superimposed on the previous scans. The curves are not 
deleted from the hard disk. 
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User info tab 

 
 

Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

Sample info This information will be stored in the dataset header. The first 
line of the information is stored in the ‘Comment’ field of the 
header, which is displayed in all graph windows. The complete 
information is stored in the ‘FL memo’ field of the dataset, and 
can be viewed using Report Builder. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 
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Parameter Description 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 

View results tab 

This page contains a toolbar in which graphics icons appear.  For further details 
on viewing data in real-time see Generic Viewing Features starting on page 74. 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Wavelength Program application enables multiple-channel time-dependent 
luminescence measurements (fluorescence, phosphorescence and 
bioluminescence) to be made at fixed wavelengths, with defined intervals over a 
specified period of time. Each channel can independently control the cuvette 
position (using the 4-position cellchanger if applicable) or wavelengths, slits 
etc., for each channel a separate graphical TimeDrive file will be displayed and 
saved automatically. 

You can freely mix the channels, collecting for example three wavelength sets 
from the first cuvette, one from the second, two from the third, etc. 
Alternatively, the Wavelength Program application can be used to collect 
multiple channels of data from a single position cellchanger.  

NOTE:  Only this last mode is possible with the LS 45. 
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Using the Application 

1. Select Wavelength Program from the Application menu. 
The Wavelength program application is opened. 

 

2. Enter the required parameters on each tab of the application.  
The parameters are discussed below. 

3. Click on the green traffic light in the toolbar to start the method. 
The View Results tab is displayed automatically, use the icons in the 
toolbar to format the graphic display. 

4. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Setup parameters tab 

 
 

Parameter Description 

Insert WL set Inserts a new line (wavelength set) into the wavelength 
program grid above the currently selected line.  

Add WL set Adds a new line (wavelength set) to the bottom of the 
wavelength program grid. 

Delete WL set Deletes the selected line (wavelength set) from the 
wavelength program grid.  

Fill down Select a cell on the required line then click Fill down to copy 
the contents of the cell vertically downwards to the bottom of 
the grid. 

NOTE:  If used on the Destination column, the selected 
filename will be automatically incremented down the grid.  

Destination This is the name of the file that will be created for the current 
wavelength program data channel.  

Ex wl Enter the excitation wavelength in nm. 
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Parameter Description 

Em wl Enter the emission wavelength in nm. 

Ex slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or  
5 nm. The best signal-to-noise ratio is obtained by selecting a 
large slit width. 

Em slit The emission slit width is the spectral bandwidth of the 
emission monochromator.  In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or  
5 nm. The best signal-to-noise ratio is obtained by selecting a 
large slit width. 

Cuv Enter the desired cuvette position for this data channel. When 
using a single position cellholder (or with the LS 45), enter 1 
as position. 

Comment The contents of this cell will be copied into the comments 
section of the dataset header.  

Start options  The options of Remote Start, Keyboard Start, and 
Immediate Start are described in Start/stop options available 
when setting up application methods on page 70. 

Duration Enter the total time for data collection in seconds or minutes 
depending on the time unit selected. 

Data interval Enter the required time interval between measurements, in 
seconds or minutes depending on the time unit selected, or 
select Set shortest interval to automatically sets the shortest 
data interval given the currently selected cuvette and 
wavelength changes. 

Integration 
time 

Enter the period of time over which the intensity will be 
measured, in seconds or minutes depending on the time unit 
selected. 
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Parameter Description 

Auto lamp off If this option is selected the lamp is switched off 
automatically between measurements. This avoids 
photobleaching of the sample and preserves the source 
lifetime for long measurements. 

Delay before 
meas 

This determines the delay between turning the source on and 
starting measurement (the instrument needs no delay, the 
source stabilizes instantly), which allows for sample 
stabilization. 

NOTE:  Range/error checking of the grid parameters is carried out immediately you 
move on from a cell in the grid. Unacceptable parameters will result in a dialog 
that specifies the row of the grid, which parameter is out of range, and what the 
permitted range for this parameter is: 

 

Customizing the Wavelength Program Grid 

1. To change the width of a column, move the mouse over the left or right 
border of the header of the column to be modified.  

The mouse pointer will change to .  

2. Hold down the left mouse button and drag the border to the desired 
position.  
The column width will be resized accordingly. 
The size of the grid and the columns is stored when the application is left 
and will be restored when the application is restarted. 
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Realtime options tab 

 
 

Parameter Description 

Background 
Subtract 

This option enables you to obtain automatic background 
subtraction of each data channel in real-time.  Each data 
channel (there may be up to 8) has its own specific 
background value for real-time subtraction. These values can 
be entered manually, or obtained automatically (before the run 
is started) by clicking Measure Background(s).  For the 4-
cellchanger, prepare one cuvette containing a background 
sample for each data channel and insert the series into the 
cellchanger. 

Ordinate label The label will be displayed on the ordinate axis of the graph 
and will be stored in the dataset. 

Ordinate Max  Sets the default ordinate maximum value.  Leave empty to 
retain the same ordinate value as last time. 

Ordinate Min Sets the default ordinate minimum value.  Leave empty to 
retain the same ordinate value as last time. 

Auto-clear 
curves 

If this option is selected all curves are deleted from the graphic 
before a measurement starts, rather than each successive scan 
being superimposed on the previous scans. The curves are not 
deleted from the hard disk. 
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User info tab 

 
 

Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 
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Parameter Description 

Save 
Spreadsheet 

This option enables you to obtain a single spreadsheet 
containing all of the data for all of the channels. The format is 
an Excel TM compatible tab-delimited ASCII file.  Enter the 
name of the spreadsheet you want to create.  

NOTE:  This is in addition to the graphical plots that are 
automatically saved. 

View results tab 

This page contains a toolbar in which graphics icons appear.  For further details 
on viewing data in real-time see Generic Viewing Features starting on page 74. 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The ICBC Calibration application is used for converting raw data into 
intracellular [ion]. The application accepts single wavelength raw data from 
TimeDrive and Wavelength Program applications, and ratio raw data from Ratio 
Data Collection, Fast Filter and Wavelength Program applications.  

For ratio data, the data for each run consists of three TimeDrive files with an 
extension of .TD.  The file name ending N, D or A is automatically added for 
identification of the data type contained within that file: 

*N.TD = numerator for ratioing the measured data 

*D.TD = denominator for ratioing the measured data 

*A.TD = ratio of the intensity values of the above files  
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Using the Application 

1. Select ICBC Calibration from the Application menu. 
The ICBC Calibration application is opened. 

 

2. Use the toolbar buttons to determine whether single wavelength or ratio 
raw data is to be calibrated. 

 
• Single wavelength input data - If the raw data to be converted to [ion] 

consists only of a single wavelength (for example, FLUO-3), then click on 
the first button. The calibration module will then show single wavelength 
structure for autofluorescence subtraction and calibration. 
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• Ratio input data - If the raw data to be converted to [ion] consists of a ratio 
of 2 wavelengths (for example, FURA-2), then click on the second button. 
The calibration module will then show wavelength ratio structure for 
autofluorescence subtraction and calibration. 

3. Use the toolbar buttons to determine whether min/max or linear calibration 
will be applied. 

 
• Min/Max calibration mode - If the conversion to [ion] algorithm involves 

min/max calibration (for example, Fmin/Fmax for FLUO-3 or Rmin/Rmax 
for FURA-2) then click on the first button. 

• Linear calibration mode - If the conversion to [ion] algorithm involves linear 
calibration (for example, for BCECF) then click on the second button. 

4. Select the raw data set(s) to be calibrated using Load Raw Data at the 
bottom of the application window. 

 

5. Set up autofluorescence options as required (see page 194) and click 
Subtract Autofluorescence (AF) on the Autofluorescence tab. 

6. Set up calibration options as described for the various options starting on 
page 196. 

7. Convert the raw data to [ion] by clicking on the Convert to [ion] on the 
Calibration tab. 

8. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Autofluorescence tab 

The appearance of the Autofluorescence tab depends on the setting of the single 
/ratio buttons.  

Single wavelength mode 

In this mode the page appears as follows: 

 

1. Enter the autofluorescence value, the intensity of a cell without any 
fluorescent dye, as AF1. 
You can use the calibration cursor to read in this data frfom a dataset, as 
described on page 201. 

2. Click on Subtract AutoFluorescence to subtract the autofluorescence 
value from the raw dataset.  
The autoflourescence subtracted data are stored in a new result dataset. For 
convenience the AF value is stored in the header of the source dataset, but 
the raw data of the source dataset are not modified.  
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Ratio mode 

In ratio mode, the tab appears as follows: 

 

1. Enter the autofluorescence values, the intensity of a cell without any 
fluorescent dye, as AF1 and AF2. 
You can use the calibration cursor to read in this data from a dataset, as 
described on page 201. 

2. Click on Subtract AutoFluorescence to subtract the autofluorescence 
value from the raw intensity datasets and re-generate the ratio dataset.  
The autoflourescence subtracted data are only stored in the ratio dataset. 
For convenience the AF values are stored in the headers of the source 
datasets, but the raw data of the source datasets are not modified.  
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Calibration tab  

The calibration tab consists of two distinct parts: the top part, which contains the 
user-interaction for calibration values, and the bottom part, which contains the 
user interaction for the formatting of the result data. The appearance of the top 
part of the tab depends on the setting of the single /ratio and the calibration type 
(min/max or linear) buttons.  

Single wavelength, min/max mode 

 

NOTE:  The on-screen help contains practical information on how to measure AF, Fmax 
and IC. Select Contents from the Help menu, and then scroll to the relevant 
topic(s). 

 

Parameter Description 

Fmin  Minimum fluorescence level, obtained during the calibration 
experiment when [ion]=0. Enter manually, or you can use the 
calibration cursor to read in this data from a dataset, as 
described on page 201. 

Fmax Maximum fluorescence level, obtained during the calibration 
experiment when [ion] is saturating. Enter manually, or you 
can use the calibration cursor to read in this data from a 
dataset, as described on page 201. 

Kd Dissociation constant, as applies to your particular 
experiment, and relevant to the temperature of the 
experiment. 
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Parameter Description 

Log Fn Select this to perform calibration using a log10 function. This 
is useful for calibration at high [ion], where min/max 
calibration has poorest linearity. 

Mn++ Fmin Select this for calibration using the equations: 

Fmin=AF+(Fmax-AF)/IC 

[Ca++]=Kd.(F-Fmin)/(Fmax-F) 

Chelated Fmin Select this for calibration using the equation:  

[Ca++]=Kd.(F-Fmin)/(Fmax-F) 

Single wavelength, linear mode 

 

1. Fill in the grid of [ion]/pH versus Intensity. 
You can use the calibration cursor to read in Intensity data from a dataset, 
as described on page 201. 

2. To add a calibration point, click +. 
Use this to set the grid to the number of pH values used in the generation of 
the calibration data. 

3. To remove a calibration point, click -. 
This removes the bottom calibration point from the grid. 
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4. When the grid is complete, click Fit line to data. 
Fits a linear least squares fit to the data points in the grid and displays the 
results of the fit under the button. 

 

Wavelength ratio, min/max mode  

 

This mode uses the calibration equation: 

[Ca++]=Kd.(R-Rmin)/(Rmax-R).SFB 

 

Parameter Description 

Rmin  Minimum ratio value, obtained during the calibration 
experiment when [ion]=0. Enter manually, or you can use the 
calibration cursor to read in this data from a dataset, as 
described on page 201. 

Rmax Maximum ratio value, obtained during the calibration 
experiment when [ion] is saturating. Enter manually, or you 
can use the calibration cursor to read in this data from a 
dataset, as described on page 201. 
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Parameter Description 

SFB Ratio of the denominator intensity components of Rmin and 
Rmax respectively.  

NOTE:  This value is automatically recalculated each time 
values are transferred back from cursor-derived calibration 
values, but if Rmin and Rmax are entered manually, then 
SFB must also be entered manually. 

Kd Dissociation constant, as applies to your particular 
experiment, and relevant to the temperature of the 
experiment. 

Log Fn Select this to perform calibration using a log10 function. This 
is most useful for calibration of data near the calibration value 
limits, where the calibration process has poorest linearity. 

 
This button expands the display of values to include the 
intensity components, and is intended for clarity only. When 
Rmin and Rmax values are obtained from calibration data 
using a cursor, the intensity components are also transferred 
automatically. When activated, the calibration section appears 
like this: 
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Wavelength ratio, linear mode  

 

1. Fill in the grid of [ion]/pH versus Intensity. 
You can use the calibration cursor to read in Intensity data from a dataset, 
as described on page 201. 

2. To add a calibration point, click +. 
Use this to set the grid to the number of pH values used in the generation of 
the calibration data. 

3. To remove a calibration point, click -. 
This removes the bottom calibration point from the grid. 

4. When the grid is complete, click Fit line to data. 
Fits a linear least squares fit to the data points in the grid and displays the 
results of the fit under the button. 
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Using the Calibration Cursor 

Many of the parameters set on the calibration tab are best done by displaying the 
dataset and using a cursor. 

1. To display a dataset and cursor, click . 
A file selector is displayed. 

2. Select a calibration dataset.  
The dataset is loaded into a graphic window where a cursor is displayed.  

3. Drag the cursor to the start of the Rmax range, then click on the calibrant 
start button  

 
The cursor value is loaded into the box to the right of the button.  

4. Drag the cursor to the end of the Rmax range then click on the calibrant end 
button: 

  
The cursor value is loaded into the box to the right of the button. 

5. Click on the average button: 

  
The result is loaded into the box to the right of the button. 
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6. To transfer data back to the application, double-click on relevant box on the 
Calibration tab of the ICBC Calibration application. 

 
The value is loaded into the box. 

Previewing autofluorescence and calibration 

 Click  to compare the current raw dataset against the current levels of 
min and max, autofluorescence etc., for diagnostic purposes. 

  

Calibration Result format 

The bottom part of the calibration page is used to define how the results file will 
be generated: 
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Parameter Description 

Convert to 
[ion] 

Convert the raw dataset (the filename in the textbox at the 
bottom of the window) to [ion] using the calibration values in 
the section at the top of the calibration page. 

Full range Sets the conversion to be over the full time limits of the raw 
dataset. Generates a graphic (****.td) result file. 

Selected range Sets the conversion to be over time limits specified by you, 
using a cursor. Generates a graphic (****.td) result file. 

Selected 
points 

Sets the conversion to be at several points (each point 
specified using a cursor). This option generates a text result 
file. 

Filename for 
result data 

Enter a filename for the results file. 

Ordinate Label Enter the ordinate label to be displayed in the results file. 

Report name Enter a filename for the calibration report, which will contain 
a full set of information describing how the calibration was 
performed. 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Concentration application enables you to perform routine quantitation of 
unknown samples. 

You can construct separate reference sample and unknown sample grids and 
measure these in any sequence: as reference samples are collected a linear 
calibration graph is constructed and updated. 

Unknown samples can be measured separately (where you select a sample for 
measurement from anywhere in the sample grid) or automatically (where you are 
prompted for each unknown sample). 

All measurement conditions, reference sample data, calibration fit data and 
unknown sample results are presented on a single page for convenience. These 
results can be printed or saved in a spreadsheet-compatible file for further work. 

For quality control work, a permitted calculated concentration range can be 
applied to the unknown samples: unknown results are then identified as ‘in 
range’ or ‘out of range’ accordingly. 

Reference sample data is stored in the application method for instantaneous 
recall and immediate unknown sample calculation. Unknown sample data can be 
stored on disk for subsequent recall (for example for checking against several 
reference calibration sets). 
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Using the Application 

1. Select Concentration from the Application menu. 
The Concentration application is opened. 

 

2. Enter the required parameters on the Setup parameters tab (see page 210) 
and the User info tab (see page 217).  

3. Set up a calibration graph as detailed on page 214. 

4. Click on the green traffic light in the toolbar to start the method. 
The way the method progresses is determined by the measurement mode 
(as set on the User info tab): 

• If Automatic run is switched off, when the measurement is started 
the Sample tab appears with three additional buttons: 

.   

Click Measure to measure the sample and automatically go to the 
next sample.  

OR 

Click Skip to skip the measurement of the sample.  

OR 

Click Redo to go back to the previous sample.  
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• If Automatic run is switched on and Keyboard Start is selected, 
you need to click Measure to perform each measurement, but the 
options to Skip or Redo are not available. After the last sample has 
been measured the button caption changes to Save. Click Save to 
automatically save the results report to the destination file name.  

• If Automatic run is switched on and Remote Start is selected, each 
measurement is started via the external remote contact closure. After 
all measurements have been performed, the results report is saved 
automatically. This mode allows for automatic data collection when 
coupled to an external device, for example an auto-sampler. 

• If Automatic run is switched on and Sipper Start is selected, each 
measurement is started via the external event contact closure, or the 
sipper button. After all measurements have been performed, the 
results report is saved automatically. This mode allows for 
automatic data collection when coupled to an external device, such 
as the Sipper accessory. 

When a measurement is taken, the sample intensity is measured and the 
background subtracted value is written into the sample grid. Then the 
concentration is calculated, using the calibration graph.   

NOTE:  The measure background button is enabled through the run, allowing you to 
redefine the background at any time.  

5. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Setup parameters tab 

 
 

Parameter Description 

Excitation 
wavelength 

Enter the excitation wavelength in nm. 

Emission 
wavelength 

Enter the emission wavelength in nm. 

Excitation 
slit  

The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or 5 nm. 
The best signal-to-noise ratio is obtained by selecting a large slit 
width. 

Emission 
slit 

The emission slit width is the spectral bandwidth of the emission 
monochromator.  In order to obtain the best spectral resolution, 
select a narrow slit width, for example 2.5 or 5 nm. The best 
signal-to-noise ratio is obtained by selecting a large slit width. 
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Parameter Description 

Integration 
time 

Enter the required integration time in seconds. The optimal 
signal-to-noise ratio is obtained by selecting a long integration 
time.  

NOTE:  Changing the integration time will invalidate an 
existing set of references. 

Em filter Select the required emission filter (with the LS 45, only Open 
can be selected. 

NOTE:  Changing the emission filter will invalidate an existing 
set of references. 

Result 
Filename 

Enter the name of the file for saving the data or double-click in 
the textbox and a file selector will be displayed to enable you to 
overwrite a previous file. 

NOTE:  Result files are always stored in the default FL WinLab 
data directory. 

Auto 
increment 
filenames 

If this option is selected the application generates a new 
numbered filename for each run. The base filename is given as 
the Result Filename, and is extended with a number starting 
from #001. If a file with this filename already exists on the hard 
disk in the current FL WinLab data directory, the number is 
incremented by one, until the filename is unique. The numbering 
process can be forced to start from a different number by adding 
a number to the base filename, for example Test#5.sp would 
make the first generated filename Test#005.sp and the second 
Test#006.sp and so on. 

Total Emission Mirror (TEM) Accessory 

The total emission mirror accessory is a plane mirror that can be moved in place 
of the emission grating and is used to collect the entire spectrum of light from 
the sample.  This increases the sensitivity by up to 20 times and is especially 
recommended for bioluminescence measurements. 
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TEM is only available if the TEM is fitted inside the instrument, and should 
always be used in conjunction with an emission cut-off filter. When the mirror is 
in the beam the emission grating is automatically moved out of the way. 

Sipper Accessory 

If the sipper accessory is fitted to the instrument, sipper parameters are available. 

 
 

Parameter Description 

Sipper on If selected, the sipper will be run before each measurement. 

Pump time Enter the length of time that the system will pump to fill the 
flowcell with the sample. 

Delay time Set the amount of time between the pump stopping and the 
measurement being taken, for instance to wait for any bubbles 
to leave the sample. 

Purge time Set the amount of time that the system purges the flowcell. 

Purge 
forwards 

Select the forwards pump direction to pump the sample to the 
waste. 

Purge reverse Select the reverse pump direction to return the sample to the 
tube. 
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References tab 

 
 

Parameter Description 

Concentration 
units 

Enter the concentration units to be used for standards and 
unknowns. 

Measure (Ref. 
ID) 

Measures the intensity of the selected reference standard.  The 
Ref. ID of the selected standard appears on the button.  

new Clears the grid and creates a new set of references. On the 
dialog displayed, enter a number and click OK to create the 
new grid.  The minimum number of references is 2, the 
maximum number is 40.  

NOTE:  All reference information will be lost unless it has 
been saved to a method. 

Insert Inserts a new reference in the grid, above the currently selected 
row. 

Add Adds a new reference at the bottom of the grid. 

Remove Removes the currently selected reference from the grid. 
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Parameter Description 

Fill down In the Ref. ID column, this will give all of the cells below the 
selected one the same name except with the number increased 
sequentially by 1.  In the Factor and Conc. columns, this will 
give all of the cells below the selected one the same value as 
the selected cell. 

clear Clears all intensities (Int.) and background (BG) values from 
the references grid. The concentration (Conc.) values of the 
sample grid are cleared as well. 

Measure 
background 

Measures the current background intensity. The value is 
displayed next to the button and used for all subsequent 
reference measurements. 

Calib. curve Select the required type of graph: Linear, Cubic, Quadratic or 
Automatic. 

Automatic will use a statistical F-test with 90% confidence 
limits to determine which type of graph to use. 

Intercept Select whether to allow an intercept on the graph, that is do not 
force the graph through 0,0. 

Creating a Calibration Graph 

1. Enter the required Concentration units. 

2. Enter the information about the reference standards (Ref. ID, Factor and 
Conc.) into the grid.  
The contents of this grid is saved in the method and in the results report. It 
is restored every time a method is loaded. 
You can change the width of the columns in the grid by moving the mouse 
pointer over the left or right border of the header of the column, so the 
mouse pointer changes to , and then hold down the left mouse button and 
drag the mouse to change the column width. 
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3. Select the type of graph you want to see by selecting the Calib. curve and 
deciding whether to allow an Intercept.  
The parameters Calib. curve and Intercept define the mathematical 
function to use for the calibration curve and the minimum number of 
reference measurements (data points): 
 

Curve Intercept Mathematical 
function 

Minimum 
number of 
standards 

Linear No y = bx 1 

Linear Yes y = bx + a 2 

Quadratic No y = cx² + bx 2 

Quadratic Yes y = cx² + bx + a 3 

Cubic No y = dx³ + bx 2 

Cubic Yes y = dx³ + bx + a 3 

NOTE:  You need at least one more reference than the minimum number required by the 
function, to obtain a reasonable correlation correction as a measure of the 
quality of the calibration. 

4. Prepare the first standard and insert it in the instrument. 

5. Select the correct row in the grid.  
The caption of the Measure button changes to reflect the standard selected.  

6. Click Measure.  
The instrument is setup with parameters on the setup page and the intensity 
measured. The reference background value (BG) and background 
subtracted intensity (Int.) are copied  into the appropriate boxes in the grid 
and a data point is added to the graph, which displays the concentration of 
the standard against the measured intensity, draws the best fit line and 
displays the parameters of the best fit. 

7. Repeat steps 4, 5 and 6 for the rest of the standards. 
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NOTE:  At least two references with different concentrations and different intensities are 
necessary to calculate a sensible fit. If a fit was calculated successfully the 
samples grid and the results page are updated accordingly.  

Samples tab 

 
 

Parameter Description 

Conc. Limits 
warning 

This option is used for rapid quality control screening. Enter 
the minimum (Low) and maximum (High) permissible 
concentration values.  Concentrations of the unknown samples 
will now be color coded: green for under-range, red for over-
range and black for in-range. 

new Clears the grid and creates a new set of samples. On the dialog 
displayed, enter a number and click OK to create the new grid. 
The minimum number of references is 2, the maximum number 
is 40.  

NOTE:  All reference information will be lost unless it has 
been saved to a method. 

Insert sample Inserts a new sample in the grid, above the currently selected 
row. 

Add sample Adds a new sample at the bottom of the grid. 
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Parameter Description 

Remove 
sample 

Removes the currently selected sample from the grid. 

fill down In the Sample ID column, this will give all of the cells below 
the selected one the same name except with the number 
increased sequentially by 1.  In the Factor and Information  
columns, this will give all of the cells below the selected one 
the same value as the selected cell. 

clear Clears all Intensity, background (BG), and concentration 
(Conc.) values from the grid and the report. 

Measure 
background 

Measures the current background intensity. The value is 
displayed next to the button and used for all subsequent 
reference measurements. 

User info tab 
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Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 

Automatic run Select this option to perform the data acquisition in automatic 
run mode, using one of the three triggers offered. If the option 
is not selected, measurements are done in Sequential 
Measurement Mode. 

Allow 
intensity edit 

Selecting this option enables you to edit the sample and 
reference backgrounds, as well as the intensities in the 
reference and sample grid. Modified intensities are color 
coded in blue and marked in the results file by a leading “*”, 
whereas the backgrounds stay unmarked. 
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View results tab 

 

This tab displays the results report and the calibration graph.  The bar down the 
middle of the window can be dragged left or right by placing the mouse pointer 
on it, holding down the left mouse button and dragging the mouse. 

Results Report 

The results report shows the measurement conditions, the reference sample 
results, line fit values and unknown results. If the concentration range option has 
been setup, results will also indicate whether samples are in or out of range. The 
results report can be resized, by dragging the split bar between the results report 
and the calibration graph (as shown by the yellow arrow above).  

Calibration Graph 

This graph displays the concentration of the references against the measured 
intensity, the best fit line, the used method and the current date. This graph can 
be printed together with the results report. 
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TLC Scan 
Application 12 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The TLC Scan application enables luminescence measurements to be made at 
fixed wavelengths for an individual position, a single scan or a multiple scan 
over the surface of any flat sample, TLC plate or gel.  Multiple scans are 
performed with a selected data collection interval, resulting in a 3D plot, which 
can be viewed in the 3D View application. 
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Using the Application 

1. Select TLC Scan from the Application menu. 
The Wavelength program application is opened. 

 

2. Enter the required parameters on each tab of the application.  
The parameters are discussed below. 

3. Click on the green traffic light in the toolbar to start the method. 
Open the View Results tab to look at the data, and use the icons in the 
toolbar to format the graphic display. 

4. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Setup parameters tab 

 
 

Parameter Description 

X, Y and Int This shows the current X and Y position of the cursor over the 
plate image, and the last measured intensity.  To get the intensity 
at the current probe head position right mouse click. This is also 
useful in determining the positional parameters for a 3D scan. 
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Parameter Description 

Left, Right, 
Top, 
Bottom and 
Delta 

To align the plate, specify the distance from the edges of the plate 
to the scan start and stop points.  For Left enter the distance from 
the left edge of the plate to the scan start point.  For Right enter 
the distance from the left edge of the plate to the scan end point.  
For Top enter the distance from the top edge of the plate to the 
scan start point.  For Bottom enter the distance from the top edge 
of the plate to the scan end point.  For Delta enter the distance 
between successive traces during a multiple run.  When finished, 
click Redraw to update the picture of the plate with these values. 

Alternatively, on the picture of the plate, click with the left mouse 
button and drag to draw the scan trace(s). The Left, Right, Top 
and Bottom values are updated accordingly. 

 

Click on the top button to scan the plate from left to right in the 
Plate Reader Accessory. 

Click on the bottom button to scan the plate from back to front in 
the Plate Reader Accessory 

 

Click on the top button to scan a single trace of the plate/gel.  

Click on the bottom button to scan multiple traces and create a 3D 
plot of the plate/gel. 

Excitation 
wavelength 

Enter the excitation wavelength in nm. 

Emission 
wavelength 

Enter the emission wavelength in nm. 

Plate scan 
speed 

The plate scan speed controls the time for the fiber optic to scan 
across the plate/gel. 

Excitation 
slit 

The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or 5 nm. 
The best signal-to-noise ratio is obtained by selecting a large slit 
width. 
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Parameter Description 

Emission 
slit 

The emission slit width is the spectral bandwidth of the emission 
monochromator.  In order to obtain the best spectral resolution, 
select a narrow slit width, for example 2.5 or 5 nm. The best 
signal-to-noise ratio is obtained by selecting a large slit width. 

Data 
interval 

Enter the required data interval (interval between two measuring 
points) in millimeters. 

Realtime options tab 

 
 

Parameter Description 

Ordinate 
label 

The label will be displayed on the ordinate axis of the graph and 
will be stored in the dataset. 

Ordinate 
Max  

Sets the default ordinate maximum value.  Leave empty to retain 
the same ordinate value as last time. 

Ordinate 
Min 

Sets the default ordinate minimum value.  Leave empty to retain 
the same ordinate value as last time. 

Auto-clear 
curves 

If this option is selected all curves are deleted from the graphic 
before a measurement starts, rather than each successive scan 
being superimposed on the previous scans. The curves are not 
deleted from the hard disk. 
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Parameter Description 

Start options  The options of Remote Start, Keyboard Start, and Immediate 
Start are described in Start/stop options available when setting 
up application methods on page 70. 

User info tab  

 
 

Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

Sample info This information will be stored in the dataset header. The first 
line of the information is stored in the ‘Comment’ field of the 
header, which is displayed in all graph windows. The complete 
information is stored in the ‘FL memo’ field of the dataset, and 
can be viewed using Report Builder. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 
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Parameter Description 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 

View results tab 

This page contains a toolbar in which graphics icons appear.  For further details 
on viewing data in real-time see Generic Viewing Features starting on page 74.  
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Application 13 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Plate Reader application enables you to perform measurements using the 
Well Plate Reader (WPR) accessory.   You can: 

• Measure samples in any plate format, for example 6, 12, 24, 48, 96 wells 

• Create new plate formats graphically and interactively 

• Define measurement points with a point and click  

• Randomly define plate measurement sequences, for example A1, B4, H12, 
A3, D5, etc. 

• Automatically select measurement blocks, for example whole plate, or 
whole plate but excluding the outer wells, etc. 

• Automatically center a reading in the middle of the well. 

• Define a measurement point anywhere in the well, typically for large wells 
as in 6 well plates 

• For multiple measurement points per well, automatically repeat the pattern 
in well A1 throughout the entire plate 

• User-programmable wavelength program (up to 20 sets) 

• Measure kinetic data from the plate for single wavelength or wavelength 
program 

• Free-format sample information spreadsheet 

• Save data in a single Microsoft Excel compatible file, on disk. 
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Using the Application 

1. Select Plate Reader from the Application menu. 
The Wavelength program application is opened. 

 

2. Enter the required parameters on each tab of the application.  
The parameters are discussed below. 

3. Click on the green traffic light in the toolbar to start the method. 
Open the View Results tab to look at the data, and use the icons in the 
toolbar to format the graphic display. 

4. To exit the application, select Exit from the File menu. 

Viewing the intensity in the well before starting a run 

It is sometimes desirable to be able to observe the intensity in one or more wells 
before starting a potentially time-consuming kinetic run.   

1. Open the View results tab 

2. Select the required wavelength program from the list.  
You can obtain the detailed parameters for the measurement from the 
wavelength program grid on the Setup parameters tab. 
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3. Open the Setup plate tab.  
The current plate format is display.  

4. Click on the well to be measured using the right mouse button. 
The Plate Reader moves to that well, sets up the parameters for the selected 
wavelength program, measures the intensity and displays the result in the 
Intensity box. 
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Setting the Parameters 

Setup parameters tab 

 
 

Parameter Description 

Add WL 
program 

Click to add a new wavelength program measurement to the 
bottom of the grid. The maximum number of wavelength 
programs is restricted to 20. 

Delete WL 
program 

Click to delete the bottom wavelength program measurement 
set. 
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Parameter Description 

Wavelength 
program 
parameters 

A wavelength program is a series of measurements, each with 
its own excitation and emission wavelengths and slits, emission 
filter position and Total Emission accessory (when fitted) 
status. The wavelength program enables you to collect multiple 
wavelength data, for example for FURA2 measurement, cell 
viability, diagnostic DNA assays, etc. 

To set up a wavelength program, enter in each line of the grid 
the parameters for a measurement. In the Ex wl and Em wl 
columns enter the excitation and emission wavelengths, 
respectively.  In the Ex slit and Em slit columns enter the 
excitation and emission slit widths, respectively. Select the 
desired emission filter from the Em filter list, and the TEM 
position from the TEM list. Enter a Description as required. 

Number of 
measurement 
cycles 

This is the number of times that the measurement sequence for 
the selected measurement points in the plate is repeated. Enter a 
number greater than 1 to define a kinetic run. 

Read time for 
each well 

This is the integration time for each wavelength program 
measurement for each defined measure point. 

Cycle time 
per plate 

This is the time taken from the start of the first measurement of 
a well to the start of the next measurement of the same well for 
each successive cycle. This value is only used for kinetic runs, 
that is, if the Number of measurement cycles is greater than 
1. 

Inject/Ext This enables you to drive up to two external devices.  This can 
be used to inject samples into the wells or to drive any other 
device that has a Windows driver (or a DOS driver if the driver 
has a Windows PIF file - see Windows help for details of 
setting up PIF files). 
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Parameter Description 

First cycle 
only 

When selected, the injector will only be driven during the first 
kinetic cycle. Otherwise the injector will be driven EVERY 
cycle of the kinetic run.  The two devices driver commands can 
be sent asynchronously, so that one of the devices is only 
activated during the first kinetic cycle but the other is activated 
for every cycle. 

Ext. 
Command 

Define the driver program and its associated command line 
parameters. Enter the file name of the driver program with its 
full path or double-click on the textbox to use a file selector. 
You can also append any command line parameters which the 
program may need (this depends of course on the driver), for 
example for an injector driver to dispense 200 microlitres from 
injector number 1, the command line may appear: 
“c:\extdrive.exe 1 200”. 

Delay The two delays which can be added during the run are 
primarily intended for use with the external device drivers, for 
example to allow for temperature equilibration after addition of 
reagent then to allow for reaction after addition of analyte. 
However, they can also be used to control the time between 
wells for long kinetic measurements.   Any delay is inserted 
after driving to the next well, and before the wavelength 
program is measured. 

Destination 
filename 

Enter the name of the file for saving the data or double-click in 
the textbox and a file selector will be displayed to enable you to 
overwrite a previous file. 

NOTE:  Result files are always stored in the default FL 
WinLab data directory. 
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Parameter Description 

Auto 
increment 
filenames 

If this option is selected the application generates a new 
numbered filename for each run. The base filename is given as 
the Result Filename, and is extended with a number starting 
from #001. If a file with this filename already exists on the hard 
disk in the current FL WinLab data directory, the number is 
incremented by one, until the filename is unique. The 
numbering process can be forced to start from a different 
number by adding a number to the base filename, for example 
Test#5.sp would make the first generated filename 
Test#005.sp and the second Test#006.sp and so on. 

 Setup plate tab 

 

Displays an image of the currently selected plate and the current set of 
measurement points. The numbers beside the measurement points indicate the 
order of the measurement.  

 To add a measurement point, left click on the desired plate position,  

 To delete a read point, hold down ALT and left click on the read point.  

 To obtain an intensity, right click on the desired position. 
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Parameter Description 

Plate 
position 

X and Y show the plate position, while the box underneath shows 
the corresponding well of the current mouse position. 

Intensity Displays the intensity for the current wavelength program, when 
you right mouse click on the desired position. 

 Will send the Plate Reader accessory to the park position. It is 
recommended that plates are inserted or removed only with the 
accessory in the parked position. 

 Resets the Plate Reader accessory and sends it to the datum (0,0) 
position. This should correspond to the extreme corner of the 
plate nearest the A1 position. 

 
Click to load a previously saved plate image (*.wpc) from file.  

NOTE:  Loading a new plate image automatically clears all 
measurement points. 

 
Selecting this means that whenever you click on a well to set a 
measurement point, the measurement point is automatically set to 
the center of the well. 

 
Selecting this means that whenever you click on a well to set a 
measurement point, the measurement point is set exactly where 
you clicked, rather than being automatically centered on the well.  
This is primarily for multiple measurements per well on 6 or 12 
well plates.  

 
If selected, multiple reads for a given well are averaged. 

 
If selected, multiple reads for a given well are summed 
(integrated). The summed values are updated in the results 
spreadsheet each time a read is performed. 

 
Used to automatically fill a pattern of measurement points. 
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Parameter Description 

 
Click to clear all measurement points from the plate image. 

 

Use to either align an existing plate or to generate a new plate 
format file.  Information about the Align plate dialog is given 
below. 

Align plate dialog 

 
 

Parameter Description 

Plate 
Image 

Displays an image of the currently defined plate. If no alignment 
button is selected right clicking on a position in the image will 
move the plate reader probe to the corresponding position over 
the plate. 
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Parameter Description 

Make 
format 

Here the complete set of the plate format parameters are 
displayed.  To define the format of a new plate, enter the values 
for the number of columns (Cols) and Rows and the Radius of 
the wells in the plate.  Then use the Spacing X and Spacing Y to 
define the distance between the centers of two neighboring wells 
in the x and y directions.  Finally, set the x and y distance of the 
A1 well to the upper right corner of the plate as Offset X and 
Offset Y.  The values for the spacing and the offsets can be given 
approximately, since they are recalculated during the alignment 
process.  

 
Press this button to select the well in upper left corner of the plate 
for alignment.  The program will automatically move the probe 
head over the appropriate well.  The upper left well on the plate 
image will be filled in red to indicate that that well is being 
aligned.  Align the probe head using the arrows.  To unselect the 
well click on this button again. 

 
Press this button to select the well in lower right corner of the 
plate for alignment.  The program will automatically move the 
probe head over the appropriate well.  The upper left well on the 
plate image will be filled in red to indicate that that well is being 
aligned.  Align the probe head using the arrows.  To unselect the 
well click on this button again. 

Alignment 
arrows 

Use the arrows to align the probe. Each time you click on one of 
the arrows the probe is moved in the indicated direction. The 
distance the probe is moved is determined by the alignment 
distance.  There will be a short delay while the program drives the 
probe head, during which time the cursor shape changes to an 
hourglass. 

Alignment 
distance 

Use these settings to define the distance the probe is moved head, 
each time an alignment arrow is pressed. Use 5 mm for the coarse 
tuning and 0.2 mm for the fine tuning. 
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User info tab 

 
 

Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

Sample info 
grid 

Displays the sample information for the plate. Note that the 
grid cannot be edited directly.  Use the buttons next to the grid 
together with the comments textbox below the buttons to edit 
the fields.  To enter information into the grid, enter text in the 
comments textbox, select a region on the sample info grid 
(drag the cursor over the desired region), then click the 
appropriate button (Blanks, Standards, or Samples). 

Clear Click to clear the selected area on the grid. 
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Parameter Description 

Blanks Blank wells can be used to subtract the background signal 
from sample intensities. Click to define the selected area as 
blanks, all cells in the area will then be color coded in gray and 
will contain the keyword blank.  If the sample info comments 
textbox (right below the buttons) contains any text, this text is 
added. 

Standards Standards wells can be used to calibrate sample intensities. 
Click to define the selected area as standards, all cells in the 
area will then be color coded in green and will contain the 
keyword Std. For standards a concentration value is required, 
which must be entered into the textbox (right below the 
buttons). 

Samples Click to define the selected area as samples, all cells in the 
area will then be color coded in blue and will contain the 
keyword Sample and if the sample info comments textbox 
(right below the buttons) contains any text, this text is added. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset. 
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View results tab 

 

 Select the desired wavelength program set from the list.  
If  intensities are measured before the run is started, the parameters of the 
selected wavelength program are sent to the instrument before the 
measurement is started.  
During a run the results of the selected wavelength program are displayed 
in the results grid with the same logical format as the plate. Cells are color 
coded depending on sample type information: white = empty, gray = blank, 
green = standard, blue = sample. 
If you have set up a wavelength program (that is more than one wavelength 
set per well), then the data in the grid can be switched in real-time to toggle 
through the wavelength program sets. Signals are automatically summed or 
averaged if more than one measurement position per well has been 
selected.  
The grid cannot be edited. 
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Defining a Kinetic Run 

Kinetic runs are used to collect time-dependent data by repeating the 
measurement sequence for the selected wells in the plate.  

1. To define a kinetic run and its parameters, select the Setup Parameters tab. 

2. Enter a value of two or more for the Number of measurement cycles.  

3. Then enter the Cycle time per plate.  
This time is taken from the start of the first measurement of a well to the 
start of the next measurement of the same well for each successive cycle. 

NOTE:  There are many events in Windows that may interfere with the cycle time.  The 
Plate Reader application monitors the cycle time for every cycle, stores these 
times in the data file, and then inserts the longest cycle time into the cycle time 
textbox at the end of the run. 

In order to obtain an accurate measure of the cycle time, it is best to enter a very 
short time for the cycle time (for example 1 second) and carry out a ‘dry run’ 
without any reagents.  This will result in the real minimum guaranteed cycle 
time being displayed and this value will be stored with the method. 

During the run, the number of cycles selected and the current cycle will be 
displayed on the status bar. After a cycle is completed the remaining time until 
the next cycle is started is displayed. 
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External Device Control 

The FL WinLab Plate Reader application has facilities for driving two external 
devices.  This can be used to inject samples into the wells or to drive any other 
device that has a Windows driver (or a DOS driver if the driver has a Windows 
PIF file - see Windows help for details of setting up PIF files). 

The devices are always activated just before measurement is made, so the Plate 
Reader will drive to a new well position, then activate the devices, add delays 
for each and then perform the wavelength program measurement. 

The two devices driver commands can be sent asynchronously, so that one of the 
devices is only activated during the first kinetic cycle but the other is activated 
for every cycle, or one device can be activated during the first kinetic cycle and 
no devices are activated subsequently. Applications for these examples would 
include: 

• A standard addition method, where the reagent is added first then successive 
sample aliquots are added and measured individually. 

• A kinetic intracellular calcium method, where the user wishes to add 
FURA2-labelled cells to a protein-bound plate at time=0, then observe the 
change in intracellular calcium with time. 

• Bioluminescence assay for ATP, where the user wishes to add luciferase 
reagent to each well, then delay to allow for temperature equilibration, then 
add ATP and measure. 

To specify the external devices, go to the Setup Parameters tab, then click on 
each Inject/Ext checkbox required. 

Then define the driver program and its associated command line parameters. To 
define the driver program, enter the file name of the driver program with its full 
path in the driver textbox or double-click on the driver textbox to use a file 
selector.  Then append any command line parameters which the program may 
need (this depends of course on the driver), for example for an injector driver to 
dispense 200 microlitres from injector number 1, the command line may appear: 
“c:\extdrive.exe 1 200”. 

If the First cycle only checkbox is checked then the injector will only be driven 
during the first kinetic cycle. Otherwise the injector will be driven EVERY cycle 
of the kinetic run.  
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So for example if the user has selected a 2 wavelength program: 

10 kinetics cycles 

injector 1 active with First cycle only checked 

10 second delay 

the program will do the following on starting the run: 

For the first cycle: 

1. Drive to the well 

2. Activate the driver #1 

3. Delay for 10 seconds 

4. Measure the wavelength program 

For every subsequent cycle (for every well selected): 

1. Drive to the well 

2. Measure the wavelength program 
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Defining the Read Pattern 

A read pattern is the sequence of locations at which measurements will be taken, 
for example A1, A2, A3, A4, etc. The read pattern can be made randomly, for 
example A1, B7, H3, etc., or the application can automatically fill in a user-
defined block for simplicity. 

Random Pattern 
To define a random pattern:  

1. Open the Setup plate tab.  

2. To automatically place the measurement point in the center of the well (this 

is very convenient) click , or click  to locate the measurement 
point anywhere in the well.  
The latter mode is intended primarily for use with plates with large wells, 
for example 6 well plates. These plates are frequently used for cell 
culturing, cell confluence, etc. where it is important to measure the whole 
volume of the well. 

3. Enter the measurement points by clicking in the well.  
The application will draw a blue circle to indicate a measurement point.  
The number associated with the blue circle indicates where in the 
measurement sequence that measurement point will occur. The sequence of 
measurement points can be made in any pattern throughout the plate, 
however only one intensity is calculated per well.  If more than one 
measurement point is located in a well the intensities are either averaged or 
summed, depending on whether the average or sum button is selected. 
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Filled Block Read Pattern 
A filled block read pattern enables you to: quickly define measurement of the 
entire plate, to ignore the outermost wells, to measure one or several columns or 
rows, or to define a smaller block inside the plate.  To define a filled block read 
pattern: 

1. Open the Setup plate tab.  

2. Select the top left well of the block by clicking on it. 

3. Select the bottom right well of the block by clicking on it. 

4. Click .  
The application then fills in the wells between these two points for 
convenience.  

5. To add measurement points to the pattern, click on the well with the left 
mouse key.  

6. To delete a measurement point from the pattern, hold down the ALT key 
and click on the unwanted well with the left mouse key. 

NOTE:  Only one intensity is calculated per well. If more than one measurement point is 
located in a well, the intensities are either averaged or summed, depending 
whether the Average or Sum button is selected. 
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Aligning a Plate Format 

Optical alignment of the Plate Reader must be carried out as specified in the 
installation.  Additionally, for every different plate type that is to be used, the 
Plate Reader application alignment procedure must be used to specify where the 
wells are in relation to the Plate Reader accessory.   

There are two issues in aligning any plate, these are: 

• The absolute dimensions of the plate 

• the well locations, the mechanical offset of the Plate Reader accessory 
compared to the datum. 

When you perform an alignment, the system records the position for well A1 
and also calculates the well-to-well spacing that applies to the plate using the 
number of columns and rows and the position of well H12.  With these co-
ordinates, the program can reproducibly position the probe head over any well in 
the plate.  

NOTE:  It is not necessary to enter accurate values for the X,Y spacing and X,Y offsets 
during the alignment, these values will be accurately calculated during the 
alignment. 

Align the plate reader as follows: 

1. Insert the plate for alignment into the Plate Reader accessory. 

2. Go to the Setup plate tab and click .  
The Align Plate dialog is displayed. 
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3. Click  to move the Plate Reader to well A1.  
Well A1 on the plate image turns red, to indicate that that well is being 
aligned. 

4. Observe the probe head in the Plate Reader accessory. If the probe head is 
not directly over the center of well A1, then alter the position by clicking 
on the arrows.  
Use the 0.2 mm, 1 mm and 5 mm step size for coarse and fine tuning.  
When you click on an arrow, there will be a short delay while the program 
drives the probe head and then returns the new position. 

5. Click  to move the Plate Reader to lowest rightmost well of the plate 
(for example, H12 for the 96 well plate).  
The appropriate well the plate image turns red.  

6. Use the arrow buttons to refine the position again. 

7. Click OK.  

8. Enter a file name and click OK. 
The plate format is saved as a file on disk.  
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Fast Filter Data Collection application is used to specify the data collection 
conditions when using the Fast Filter accessory.   

The Fast Filter accessory enables rapid measurement of intracellular 
concentrations, and consists of one or two filter wheels, which are installed in 
either or both of the excitation or emission monochromators.  Up to two pairs of 
filters or polarizers can be fitted on each filter wheel: the filter wheels rotate 
rapidly and enable each filter to be in the beam coincident with the flash of the 
lamp.  A data point is then measured.   

For example, if calcium changes are being monitored using FURA-2, one 
excitation filter wheel (with a pair of filters, 340 and 380 nm) is fitted in the 
instrument in place of the standard excitation filter wheel and the emission is 
monitored at 510 nm using the emission monochromator.  The data is recorded 
and saved on the hard disk in a file with the extension .TD. 

The polarizer filter set can be fitted to calculate the polarization or anisotropy of 
a sample.  Fluorescence polarization is a very powerful technique for studying 
the rotational movement of molecules dynamically.  This technique can be used 
for a wide variety of applications, including: 

• the measurement of the binding of coenzymes to proteins,  

• membrane structure and function research,  

• biopolymer structure research, 

• the study of antigen-antibody reactions in determining low molecular weight 
haptens (Immunoassays). 

Polarization is calculated using the following equation: 

( )
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Anisotropy is calculated using the following equation: 

( )
( )vhvv

vhvv

IGF2I
IGFI

Anisotropy
⋅⋅+

⋅−
=  

where: 

Polarization = Corrected polarization, 

IVV = Emission intensity with both excitation and emission polarizers 
vertical. 

IVH = Emission intensity with excitation polarizer vertical and emission 
polarizer horizontal. 

GF = Grating factor 
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Using the Application 

1. Select Fast Filter Data Collection from the Application menu. 
The Fast Filter Data Collection application is opened. 

 

2. Enter the required parameters on each tab of the application.  
The parameters are discussed below. 

3. Click on the green traffic light in the toolbar to start the method. 
Open the View Results tab to look at the data, and use the icons in the 
toolbar to format the graphic display. 

4. To exit the application, select Exit from the File menu. 
 



FL WinLab Software User’s Guide 

258 

Setting the Parameters 

Setup parameters tab 

The Setup parameters tab has three distinct sections: 

• Mode selection 

• Mode specific settings 

• General settings 

Selecting the mode 

 
 

Parameter Description 

Excitation FFA Select this option to run the excitation fast filter wheel.  

Emission FFA Select this option to run the emission fast filter wheel. 

Polarization Select this option to calculate the polarization of a sample. 
Your instrument must have an excitation and an emission 
fast filter wheel fitted, and the positions of the horizontal and 
vertical polarizer for the excitation and the emission fast 
filter wheel must have been defined in the Status application 
(see page 52). 

Anisotropy Select this option to calculate the anisotropy of a sample. 
Your instrument must have an excitation and an emission 
fast filter wheel fitted, and the positions of the horizontal and 
vertical polarizer for the excitation and the emission fast 
filter wheel must have been defined in the Status application 
(see page 52). 



Fast Filter Data Collection Application 

259 

Parameter Description 

GF Select this option to collect grating factor data using spinning 
Fast Filters. Your instrument must have an excitation and an 
emission fast filter wheel fitted, and the positions of the 
horizontal and vertical polarizer for the excitation and the 
emission fast filter wheel must have been defined in the 
Status application (see page 52). 

Excitation FFA specific parameters 

 

NOTE:  When the Excitation Fast Filter is selected, the excitation wavelength is fixed at 
zero order to allow the excitation wavelength to be defined solely by the Fast 
Filter, so the excitation wavelength is not entered here. 

 

Parameter Description 

Emission mono Enter the fixed emission wavelength in nm. 

Excitation slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best 
spectral resolution, select a narrow slit width, for example 
2.5 or 5 nm. The best signal-to-noise ratio is obtained by 
selecting a large slit width. 

Emission slit The emission slit width is the spectral bandwidth of the 
emission monochromator.  In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or  
5 nm. The best signal-to-noise ratio is obtained by selecting a 
large slit width. 
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Emission FFA specific parameters 

  

NOTE:  When the Emission Fast Filter is selected, the emission wavelength is fixed at 
zero order to allow the emission wavelength to be defined solely by the Fast 
Filter, so the emission wavelength is not entered here. 

 

Parameter Description 

Excitation mono Enter the fixed excitation wavelength in nm. 

Excitation slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best 
spectral resolution, select a narrow slit width, for example 
2.5 or 5 nm. The best signal-to-noise ratio is obtained by 
selecting a large slit width. 

Emission slit The emission slit width is the spectral bandwidth of the 
emission monochromator.  In order to obtain the best 
spectral resolution, select a narrow slit width, for example 
2.5 or 5 nm. The best signal-to-noise ratio is obtained by 
selecting a large slit width. 

Polarization, Anisotropy, GF specific parameters 

  
 

Parameter Description 

Excitation mono Enter the fixed excitation wavelength in nm. 
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Parameter Description 

Emission mono Enter the fixed emission wavelength in nm. 

Excitation slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best 
spectral resolution, select a narrow slit width, for example 
2.5 or 5 nm. The best signal-to-noise ratio is obtained by 
selecting a large slit width. 

Emission slit The emission slit width is the spectral bandwidth of the 
emission monochromator.  In order to obtain the best 
spectral resolution, select a narrow slit width, for example 
2.5 or 5 nm. The best signal-to-noise ratio is obtained by 
selecting a large slit width. 

Generic parameters 

 
 

Parameter Description 

Start options  The options of Remote Start, Keyboard Start, and Immediate 
Start are described in Start/stop options available when setting 
up application methods on page 70. 
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Parameter Description 

Duration Enter the total time for data collection in seconds. 

Data 
interval 

Enter the required time interval between measurements, in 
seconds.  In excitation and emission modes the data interval is 
equivalent to the integration time. 

Autoname 
destination 
filenames 
into families 

When this option is selected, destination filenames for all 
channels are automatically edited when any one filename is 
changed from the keyboard.  If Excitation FFA or Emission FFA 
is selected, the endings n, d, and a are automatically added to the 
filenames in Channels 1/2, 3/4, and 5/6, respectively.  n and d 
refer to the numerator and denominator datasets respectively, a 
refers to the ratio dataset generated as n/d. If Polarization, 
Anisotropy or GF is selected, the endings v, h, and p are 
automatically added to the filenames in Channels 1/2, 3/4, and 
5/6, respectively. 

Result 
filenames 

The result files are grouped in two sets of three files: the leftmost 
two files correspond to the FFA positions channel 1 and channel 
3, and then channel 2 and channel 4. The rightmost file contains 
the result of the ratio calculation.  

The comments in brackets are the wavelengths (or polarization) 
of the filters fitted in the appropriate FFA positions. This 
information must have been previously defined by the user in the 
FFA-dialog of the Status application. 

It is possible to leave a complete group empty, in this case no 
data is stored. If one textbox of a group contains a file name the 
other two textboxes of the group must contain file names as well. 
In polarization, anisotropy or GF mode only the first or the 
second set of files is measured, not both. 

NOTE:  The files are always stored in the default FL WinLab 
data directory. 
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Parameter Description 

Auto 
increment 
filenames 

If this option is selected the application generates a new 
numbered filename for each run. The base filename is given as 
the Result Filename, and is extended with a number starting 
from #001. If a file with this filename already exists on the hard 
disk in the current FL WinLab data directory, the number is 
incremented by one, until the filename is unique. The numbering 
process can be forced to start from a different number by adding 
a number to the base filename, for example Test#5.sp would 
make the first generated filename Test#005.sp and the second 
Test#006.sp and so on. 

Realtime options tab 

The Realtime options tab has two distinct sections: 

• Mode specific settings 

• General settings 

Excitation/Emission FFA specific options 

 
 

Parameter Description 

Background 
Subtract 

This option enables you to obtain automatic background 
subtraction of each data channel in real-time.  Each of the four 
channels has its own specific background value for real-time 
subtraction. These values can be entered manually, or obtained 
automatically (before the run is started) by clicking Measure 
background.   
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Polarization/Anisotropy specific options 

 
 

Parameter Description 

Grating factor Enter the grating factor manually or calculate it by inserting 
the sample to be measured into the cuvette holder and clicking 
Auto GF calculation. 

Generic options 

 
 

Parameter Description 

Ordinate 
label 

The label will be displayed on the ordinate axis of the graph and 
will be stored in the dataset, except for the intensity datasets (c1-
c4), in which case the ordinate labels are always set to Int. 

Ordinate 
Max  

Sets the default ordinate maximum value.  Leave empty to retain 
the same ordinate value as last time. 

Ordinate 
Min 

Sets the default ordinate minimum value.  Leave empty to retain 
the same ordinate value as last time. 

Auto-clear 
curves 

If this option is selected all curves are deleted from the graphic 
before a measurement starts, rather than each successive scan 
being superimposed on the previous scans. The curves are not 
deleted from the hard disk. 

Show all 
data 

If this option is selected, all generated data sets are displayed in 
real-time. Otherwise only the result dataset(s) (ratio or 
polarization/anisotropy) are displayed. However, in both cases 
all data sets are stored. 
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User info tab 

 
 

Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

Sample info This information will be stored in the dataset header. The first 
line of the information is stored in the ‘Comment’ field of the 
header, which is displayed in all graph windows. The complete 
information is stored in the ‘FL memo’ field of the dataset, and 
can be viewed using Report Builder. 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 
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Parameter Description 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 

View results tab 

This page contains a toolbar in which graphics icons appear.  For further details 
on viewing data in real-time see Generic Viewing Features starting on page 74. 

 

NOTE:  There is a difference in ordinate scale between the intensities and the ratio. 
Select the ratio dataset and then on the expand ordinate button in the toolbar. 
The ratio dataset will then be expanded to fill the ordinate scale for clarity. 

 



 

 

Ratio Data 
Application 15 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Ratio Data Collection application is used for measuring changes in the 
intracellular concentration of free ions such as Ca++ and H+ in living cells using 
ion-specific fluorescent probes. The fluorescent characteristics of probes such as 
FURA-2, INDO-1 and BCECF change depending on the intracellular 
concentration of the free ion. The binding of an intracellular ion to a probe 
results in a shift in the excitation or emission wavelength and thus the overall 
spectrum will contain contributions from both bound and free probe.  The ratio 
of the fluorescence intensities at the maxima for bound and free forms of the 
probe is proportional to the concentration of the metabolite. The ratioing corrects 
for artifacts such as cell count, probe concentration and instrument specific 
factors. 

Data is collected by driving either the excitation or the emission monochromator 
between the two wavelengths of interest for the duration of the analysis. To 
minimize time discrepancies, due to the time interval between measuring each 
intensity, interpolation is carried out before the ratio is generated from the 
intensities. 

The data for each run is saved in three TimeDrive files with an extension of .TD.  
The file name ending N, D or A is automatically added for identification of the 
data type contained within that file: 

*N.TD = numerator for ratioing the measured data 

*D.TD = denominator for ratioing the measured data 

*A.TD = ratio of the intensity values of the above files 

NOTE:  Using the ICBC Calibration application, as described in section 10 starting on 
page 191, raw data from the Ratio Data Collection application can be converted 
to [ion] or pH. 
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True Ratio Mode 

When the true ratio mode is selected, the data is collected by rapidly driving the 
monochromator backwards and forwards between the wavelengths of interest for 
the duration of the analysis. The intensities are recorded at each wavelength.  

To minimize time discrepancies, due to the time interval between measuring 
each intensity, interpolation is carried out before the data is ratioed. The 
following scheme shows as how the ratio is calculated from two data sets 
collected at A nm and B nm, where A and B stand for a pair of excitation and 
emission wavelengths: 

 

Here the second ratio is calculated by interpolating between two A nm 
measurements to find the intensity at the time that the B nm measurement was 
made. The value obtained from the interpolation is ratioed with the value of the 
B nm measurement. The next ratio is calculated from the second measured A nm 
value and an interpolated B nm value. 
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Quick Ratio Mode 

In order to increase the rate of data collection when the quick ratio mode is 
selected the data is ratioed against the isobestic point. The isobestic point is the 
wavelength at which the fluorescence intensity is independent of metabolic 
concentration. The intensity of the isobestic point changes very slowly and this 
removes the need to continually monitor the intensity at the wavelength.  

The data is collected by measuring the isobestic point intensity followed by 
performing a single wavelength TimeDrive. At the end of the TimeDrive the 
intensity of the isobestic point is measured again. During the TimeDrive the data 
displayed is on the screen is the ratio of the TimeDrive and the first isobestic 
point intensity. When the second isobestic point has been measured the 
experimental ratios are re-calculated using linear interpolation between the two 
isobestic points as the denominator: 

 

Since the metabolite concentration data is still determined from ratio 
measurements the data are independent of cell path length, probe concentration 
and other instrumental factors. 
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Determining the Isobestic point 

To determine the isobestic point, for example for FURA-2, perform excitation 
scans (excitation wavelength 300-400 nm, emission wavelength 509 nm, 
emission slit width and excitation slit width 5nm) for various calcium 
concentrations. The Isobestic point excitation wavelength can then be 
determined from the crossing point of the curves as shown below. The Isobestic 
point emission wavelength is 509 nm. 

 

For other wavelength shifting fluorescent dyes, the isobestic point is always the 
spectral wavelength that is independent of ion-concentration. For specific details 
refer to “Handbook of Fluorescent probes and Research Chemicals” by Richard 
P.Haugland. 
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Using the Application 

1. Select Ratio Data Collection from the Application menu. 
The Ratio Data Collection application is opened. 

 

2. Select the required mode.   
True Ratio Mode means that the application collects a ratio of two 
wavelengths continuously, whereas Quick Ratio Mode uses the isobestic 
point once before and once after the collection of a single wavelength 
TimeDrive. This mode therefore does not collect true ratio data: it is 
assumed that the isobestic point intensity is either static or changes linearly.  

3. Enter the required parameters on each tab of the application.  
The parameters are discussed below. 

4. Click on the green traffic light in the toolbar to start the method. 
Open the View Results tab to look at the data, and use the icons in the 
toolbar to format the graphic display. 

5. To exit the application, select Exit from the File menu. 
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Setting the Parameters 

Setup parameters tab 

 
 

Parameter Description 

Excitation wl Enter the excitation wavelength for the relevant channel in 
nm. 

Emission wl Enter the emission wavelength for the relevant channel in 
nm. 

Channel 2  
(True Ratio 
mode only) 

For emission ratioing, enter the same excitation wavelength 
for both channels and for excitation ratioing, enter the same 
emission wavelength for both channels. 

Isobestic point 
(Quick Ratio 
mode only) 

Enter the emission and excitation wavelengths for the 
isobestic point in nm. 
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Parameter Description 

Excitation slit The excitation slit width is the spectral bandwidth of the 
excitation monochromator. In order to obtain the best 
spectral resolution, select a narrow slit width, for example 
2.5 or 5 nm. The best signal-to-noise ratio is obtained by 
selecting a large slit width. 

Emission slit The emission slit width is the spectral bandwidth of the 
emission monochromator.  In order to obtain the best spectral 
resolution, select a narrow slit width, for example 2.5 or 5 
nm. The best signal-to-noise ratio is obtained by selecting a 
large slit width. 

Start options The options of Remote Start, Keyboard Start, Immediate 
Start, and Show timed events are described in Start/stop 
options available when setting up application methods on 
page 70. 

Duration Enter the total time for data collection in seconds or minutes 
depending on the time unit selected. 

Integration time 
 

Enter the required integration time in seconds. The optimal 
signal-to-noise ratio is obtained by selecting a long 
integration time. However for fast kinetics a short integration 
time should be used. 

NOTE:  For Quick Ratio Mode, the integration time is 
automatically set to the Data Interval. 

Data Interval Enter the required time interval between measurements in 
seconds or click Set shortest interval to automatically set 
the shortest data interval. The minimum data interval for 
True Ratio Mode is determined by the sum of integration 
time and the time the monochromators need to move 
between the desired wavelengths for channel1 and channel2. 

NOTE:  For Quick Ratio Mode, Set shortest interval is not 
available. 
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Parameter Description 

Autoname 
destination 
filenames into 
families 

When this option is selected, destination filenames for all 
channels are automatically edited when any one filename is 
changed from the keyboard. The endings denote the data 
type within each file: 

*N.TD: Channel 1 TimeDrive = numerator for the ratioing of 
the measured data 

*D.TD: Channel 2 TimeDrive = denominator for the ratioing 
of the measured data 

*A.TD: Channel 1 TimeDrive/Channel 2 TimeDrive = ratio 
of the intensity values 

Filenames Three result files are generated and saved:  

Channel 1 TimeDrive = numerator for the ratioing of the 
measured data 

Channel 2 TimeDrive = denominator for the ratioing of the 
measured data 

Channel 1 TimeDrive/Channel 2 TimeDrive = ratio of the 
intensity values. 

The filenames can either be entered manually or by double-
clicking on a field to display the file selector. 

NOTE:  The files are always stored in the default FL 
WinLab data directory. 
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Parameter Description 

Auto increment 
filenames 

If this option is selected the application generates a new 
numbered filename for each run. The base filename is given 
as the Result Filename, and is extended with a number 
starting from #001. If a file with this filename already exists 
on the hard disk in the current FL WinLab data directory, the 
number is incremented by one, until the filename is unique. 
The numbering process can be forced to start from a different 
number by adding a number to the base filename, for 
example Test#5.sp would make the first generated filename 
Test#005.sp and the second Test#006.sp and so on. 

Realtime options tab 

 
 

Parameter Description 

Background 
Subtract 

Select this option to automatically subtract the given Intensity 
from the signal.  The Intensity can either be entered manually or 
automatically by clicking Measure background.  

Ordinate 
label 

The label will be displayed on the ordinate axis of the graph and 
will be stored in the dataset. 

Ordinate 
Max  

Sets the default ordinate maximum value.  Leave empty to retain 
the same ordinate value as last time. 

Ordinate 
Min 

Sets the default ordinate minimum value.  Leave empty to retain 
the same ordinate value as last time. 
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Parameter Description 

Auto-clear 
curves 

If this option is selected all curves are deleted from the graphic 
before a measurement starts, rather than each successive scan 
being superimposed on the previous scans. The curves are not 
deleted from the hard disk. 

Show all 
data 

If this option is selected all generated data sets are displayed in 
real-time, otherwise only the ratio dataset is displayed. However, 
in both cases all data sets are stored. 

User info tab 

 
 

Parameter Description 

Analyst The name is automatically taken from the configuration 
dialog, but can be altered for documentation purposes. The 
name is saved in the header of any collected datasets and, if a 
method is saved, in the header of the method. 

Sample info This information will be stored in the dataset header. The first 
line of the information is stored in the ‘Comment’ field of the 
header, which is displayed in all graph windows. The complete 
information is stored in the ‘FL memo’ field of the dataset, and 
can be viewed using Report Builder. 
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Parameter Description 

last modified This shows the date the current method was last saved. 

by This shows the name of the analyst who last saved the method. 

locked This option enables the locking of all entries in a method. The 
option can be altered in Expert mode only. If the option is 
selected all entry fields and the Method save command are 
disabled. 

Comments The comment in this textbox is saved in the method header 
and is also displayed in the method window of the software, 
but is not saved in the dataset (use Sample info for comments 
to be saved in datasets). 

View results tab 

This page contains a toolbar in which graphics icons appear.  For further details 
on viewing data in real-time see Generic Viewing Features starting on page 74. 

 

NOTE:  There is a difference in ordinate scale between the intensities and the ratio. 
Select the ratio dataset and then on the expand ordinate button in the toolbar. 
The ratio dataset will then be expanded to fill the ordinate scale for clarity. 
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Introduction 

NOTE:  For general information on using Applications, see Using Application Methods 
starting on page 65. 

The Validation application is used for quantitatively measuring performance 
characteristics of the instrument.  Sensitivity (by Raman band signal-to-noise) 
and wavelength accuracy are tested automatically. 
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Using the Application 

1. Select Validate from the Application menu. 
The Validation application is opened. 

 

2. Insert the sealed water cell.  

3. Click on the green traffic light in the toolbar to start the validation. 
Validation begins. 
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4. When validation is complete the final report is displayed and you can print 
the report. 

 

5. To exit the application, select Exit from the File menu. 
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Functional description 

Sensitivity 

Sensitivity of the instrument is determined by determination of the signal to 
noise value for the Raman band of water. Parameters are as follows. 

Raman band scan (for signal measurement) 

• Excitation wavelength 350 nm 

• Emission scan range 380 nm-420 nm 

• Slits 10/10 nm (Ex/Em) 

• Scan speed 120 nm/min 

Raman band TimeDrive (for noise measurement) 

• Excitation wavelength 350 nm 

• Emission wavelength ~397 nm (determined from scan) 

• Slits 10/10 nm (Ex/Em) 

• Response 4 seconds 

Signal-to-noise testing 

• The Raman band peak positions and intensity are derived from the scan. 
Peak height is automatically baseline subtracted. 

• Noise values (R.M.S. and peak-to-peak) are derived from the TimeDrive (at 
the peak wavelength, not on the baseline) and the signal-to-noise value and 
Raman peak positions generated and written into the report. 

• If the signal to noise passes the minimum specified value (500:1 R.M.S.), 
then the report is marked accordingly. If the value is below this, then a 
Failed comment is added to the sensitivity result section. 
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Wavelength accuracy 

The positions of the Raman band peak is also tested.  If this falls within the 
acceptance limits, then the report is marked accordingly. If the wavelength is 
outside the acceptance limits, then a Failed comment is added to the sensitivity 
result section. 

The wavelength accuracy is tested more stringently by recording Rayleigh 
scatter peaks at 350 nm and 550 nm.  The excitation wavelength is set to the 
nominal wavelength, and then the emission monochromator is scanned through 
the excitation wavelength. The position of the Rayleigh scatter peak, which is 
expected to be at the excitation wavelength, is then verified. Acceptance criteria 
for these scatter peaks depend on the wavelength position and the slit width used 
to record the scans. 

Acceptance criteria 

The acceptance criteria are displayed on the dialog: 

 

NOTE:  During data collection, the expected region of the Raman band and of the two 
wavelength accuracy peaks is indicated by a green range box, for quick 
reference of the current data against the acceptance criteria. 
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